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1 ABOUT GISPIPE  

GISpipe is an integrated GIS-Based Water and Stormwater/Sewer Network Analysis Software program. 
GISpipe is an advanced, user-friendly software solution that seamlessly integrates GIS, EPANET, and 
SWMM, making it ideal for the design, analysis, and operation of water supply and 
stormwater/sewerage systems. Developed based on Geographic Information Systems (GIS), the 
software includes key components such as the water distribution network modelling tool EPANET, the 
stormwater modelling tool SWMM, and surface runoff models. 
 
Wƛƴōƻ{ƻŦǘΩǎ Ƴƛǎǎƛƻƴ ƛǎΣ ōŀǎŜŘ ƻƴ ǘƘŜ ŜȄǘŜƴǎƛǾŜ ŜȄǇŜǊƛŜƴŎŜ ƛƴ ƛƴŦƻǊƳŀǘƛƻƴ ǘŜŎƘƴƻƭƻƎȅ ŀƴŘ geospatial 
systems, to deliver world-class tools for water distribution modelling and analysis. The goal is to 
develop industry-leading software that empowers engineers, utilities, and planners to design and 
manage efficient, reliable, and sustainable water distribution networks. 
 

 
 
Some of the key features of GISpipe include: 
 
1. Integrated GIS + hydraulic modelling 
GISpipe combines Geographic Information Systems (GIS) with the proven analytical engines of EPANET 
(for water distribution) and SWMM (for sewerage and stormwater) into a single platform. 

¶ No need for third-party GIS software such as AutoCAD or ArcView 

¶ Native spatial data integration streamlines your workflow 

¶ Map-based modelling interface simplifies network visualization and updates 
 
2. Intuitive graphical user interface (GUI) 
GISpipe is designed for engineers and planners, not just programmers. 

¶ Drag-and-drop design with real-time map feedback 

¶ Simple toolbars and logical workflows reduce the learning curve 

¶ Visual error-checking and result interpretation directly on the map 
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3. Efficient data management and editing tools 
Save time with smart data management: 

¶ Built-in tools for data import/export, cleaning, and validation 

¶ Features like undo/redo, batch editing, pipe splitting/merging, and node adjustment 

¶ Seamless integration of attribute data (e.g., demand, elevation, pipe material) 
 
4. Fast and accurate simulation 
Leverage powerful hydraulic and hydrologic simulations: 

¶ High-speed performance even for large networks 

¶ Accurate hydraulic calculations using industry-standard algorithms 

¶ Visual results display: pressures, flows, velocities, headlosses, water age, and more 
 
5. One-stop solution 
GISpipe eliminates the need for multiple tools: 

¶ Design, analyse, and optimize water and stormwater/sewer systems in a single 
environment 

¶ Easily switch between EPANET and SWMM workflows depending on your project 

¶ Ideal for municipalities, consultants, and utility operators 
 

6. Project planning and lifecycle management 
Plan beyond hydraulics: 

¶ GISpipe helps assess design alternatives, compare scenarios, and support asset 
management 

¶ Export results and reports for documentation and decision-making 

¶ Useful for both greenfield designs and rehabilitation projects 
 
 

 

GISpipe is built with a user-centric design philosophy. Its modern 
and intuitive graphical user interface (GUI) minimizes the learning 
curve, allowing users to begin working productively with minimal 
training. Tasks such as network layout, data entry, and model 
execution are presented in a logical and accessible manner, 
ǎƛƎƴƛŦƛŎŀƴǘƭȅ ǊŜŘǳŎƛƴƎ ǇǊƻƧŜŎǘ ǎŜǘǳǇ ǘƛƳŜΦ ²ƘŜǘƘŜǊ ȅƻǳΩǊŜ ŀ 
seasoned engineer or a first-time user, the software ensures a 
smooth and guided experience throughout. 

 

GISpipe is optimized to handle large and complex datasets with 
speed and precision. By integrating GIS data directly into the 
modelling workflow, users can quickly validate existing 
infrastructure layouts, perform hydraulic and hydrologic analyses, 
and calibrate models using real-world data. The platform supports 
batch operations and high-speed simulations, making it possible 
to complete detailed pipe network plans and scenario analyses 
faster than ever, while maintaining the highest level of accuracy. 
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Engineers often require the ability to adjust and refine models 
quickly, and GISpipe delivers with a suite of advanced editing 
tools. Features such as undo/redo, copy and paste, pipe splitting, 
and point merging enable users to manipulate network geometry 
effortlessly. The software also includes live feedback on changes, 
allowing users to immediately visualize the impact of edits. After 
running a simulation, results such as pressure, flow, and surcharge 
levels can be displayed directly on the map, making it easy to 
assess system performance and identify issues. 

 

GISpipe eliminates the need for external CAD or GIS software like 
AutoCAD, ArcView, or third-party plugins. All essential functions, 
from spatial data handling and network modelling to result 
visualization, are fully integrated into a single environment. This 
not only simplifies the software ecosystem but also ensures 
compatibility and seamless performance across the entire 
workflow. With GISpipe, users can manage the entire lifecycle of 
a water or stormwater/sewer system model, plan, design, 
analyse, and report, without leaving the application. 

 
 

1.1 Relationship with EPANET 

 
GISpipe uses EPANET 2.2 as its underlying computational engine. All hydraulic and water quality 
simulations are executed through the EPANET framework, ensuring compatibility with industry-
standard modelling approaches. 
 
While EPANET uses a schematic (non-georeferenced) map, GISpipe incorporates true spatial 
referencing (e.g., UTM zones, EPSG codes), allowing the user to model real-world pipe networks over 
topographic or cadastral base mapsΦ DL{ǇƛǇŜ ŀƭǎƻ ŜȄǘŜƴŘǎ 9t!b9¢Ωǎ ōasic interface by offering: 

¶ Enhanced data table interfaces for rapid inspection and editing 

¶ GIS-based topology management and attribute-driven controls 

¶ Integrated tools for batch editing, validation, and visual filtering 
 
Users familiar with EPANET will find GISpipe intuitive, with the added benefit of real-world spatial 
context and streamlined workflows. 
 

1.2 Relationship with EPAWMM 

 
GISpipe integrates EPA SWMM 5.2 as its computational engine for stormwater and surface runoff 
simulations. All hydrologic and hydraulic routing calculations, including runoff generation, infiltration, 
and flow through stormwater networks, are processed using SWMMΩǎ ǇǊƻǾŜƴ ƳƻŘŜƭƭƛƴƎ ŦǊŀƳŜǿƻǊƪΦ 
 
Whereas SWMM traditionally relies on a schematic interface, GISpipe provides a fully georeferenced 
modelling environment, enabling the representation of stormwater elements (e.g., subcatchments, 
junctions, conduits, storage units) over high-resolution GIS maps and layers. 
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GISpipe enhances the standard SWMM interface through: 
 

¶ Spatially-linked subcatchment delineation tools and automatic network connectivity. 

¶ Rainfall and land use data integration with batch import/export from standard formats. 

¶ Embedded time-series and climatology assignment per node or subcatchment. 

¶ Thematic mapping of simulation results (e.g., runoff, ponding, depth profiles) using intuitive 
colour legends. 

 
Users experienced with SWMM will find the transition to GISpipe seamless, while benefiting from an 
enriched spatial interface and improved workflow for scenario creation, validation, and reporting. 
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2 SYSTEM REQUIREMENTS 

System requirements for installing and running GISpipe. 
 
Operating system 
 

¶ Windows - Windows 10 or later (64-bit recommended) 

¶ Linux - Ubuntu 20.04 or compatible distribution (for advanced users) 

¶ macOS - Not natively supported (may work using emulation/virtualisation, but not officially 
recommended) 

 
Hardware requirements 
 

Component Minimum requirement Recommended requirement 

Processor Dual-core 2.0 GHz Quad-core 3.0 GHz or higher 

RAM 4 GB 8ς16 GB 

Storage 500 MB for software + project files SSD with 2 GB free space 

Graphics Integrated graphics supported Dedicated GPU for large datasets 

Display 1280×768 resolution 1920×1080 or higher 

 
Software dependencies and additional requirements 
 

¶ .NET Framework 4.8 or later (for Windows users) 

¶ QGIS 3.x (optional, for visualisation and export) 

¶ Administrator rights for installation 

¶ Internet connection for software activation, updates, and cloud integration features (if used) 
 
Licensing and activation 
 

¶ Requires a valid license key from the developer or distributor. 

¶ Offline activation options may be available upon request. 
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3 INSTALLING THE PROGRAM 

Step 1: Obtain the installation package 

¶ Download the latest version of the GISpipe installer from the official website or from your 
software provider. 

¶ Ensure the downloaded .exe is from a trusted source. 
 
Step 2: System preparation 

¶ Verify that the system meets the minimum requirements (see previous paragraph). 

¶ Ensure to have: 
o Administrative rights to install software. 
o .NET Framework 4.8 or later installed (usually comes with Windows 10+). 

 
Step 3: Run the installer 

¶ Double-click the GISpipe_Setup.exe file. 

¶ Follow the on-screen instructions: 
o Accept the license agreement. 
o Choose the installation directory (default is usually C:\Program Files\GISpipe). 
o Select any optional components if prompted (e.g., database integration, examples). 

 
Step 4: Activate the software 

¶ After installation, launch GISpipe. 

¶ Under the Help menu click on Request for use 
o Enter your email address 
o Enter your company name 
o Enter your phone number 
o Click on the Okay button 

¶ The request will be sent to activate the software once confirmation of payment has been 
received. 

 
Step 5: Verify installation 

¶ Open a test project or import sample pipeline shapefiles (downloadable from the website). 

¶ Ensure tools and features load without error. 

¶ Confirm output generation (e.g., reports, network layout, hydraulic calculations). 
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4 PURCHASING THE SOFTWARE 

The software will function in demo version but once the Software protection dongle is detected by 
the software it changes to a full working program. The demo version is limited i.e., not allowing saving, 
analysing and some advance functions.  
 
Full license 

¶ One-time single license activation fee 

¶ Unlocks all core features and modules: 

o Full GIS-based pipe network design tools 

o EPANET and SWMM integration for hydraulic and hydrological modelling 

o Advanced editing and analysis tools 

o Full project save/export capabilities 

¶ Includes 12 months of: 

o Software updates 

o Email-based technical support 
 
Annual subscription fee 
Paid from year 2 onward ensures: 

¶ Continued access to updates and improvements 

¶ Ongoing technical support 

¶ Access to new features and user-requested enhancements 
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5 DISCLAIMER 

Warning 
This computer program is protected by copyright law and international treaties. Unauthorized 
reproduction or distribution of this program, or any portion of it, may result in severe civil and 
criminal penalties and will be prosecuted to the maximum extent possible under law. 
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6 GETTING STARTED 

Welcome to GISpipe ς a powerful software tool designed for the hydraulic analysis and management 
of pipe networks using geographic information system (GIS) integration. This section will guide the user 
through the initial setup and provide the foundational steps needed to begin using the program 
effectively. 

 
 
GISpipe can be run by double clicking on the program icon  
in the Windows Program Manager.   
 
The main screen will be shown as depicted in Figure 6-1 below. 
 

 
Figure 6-1: GISpipe main screen 
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7 DL{tLt9Ω{ ²hwY{t!/9 

This section ŘƛǎŎǳǎǎŜǎ ǘƘŜ ŜǎǎŜƴǘƛŀƭ ŦŜŀǘǳǊŜǎ ƻŦ DL{ǇƛǇŜΩǎ ǿƻǊƪǎǇŀŎŜΦ Lǘ ŘŜǎŎǊƛōŜǎ ǘƘŜ ǾŀǊƛƻǳǎ ŀǊŜŀǎ ƻŦ 
the program (Main Menu Area, the Layer Control Panel, Map Viewer, Time Control Area and Status 
Bar). It also shows how to set program options. 
 

 
Figure 7-1: Main screen layout and features 

 
 Main Menu Area 

 
It consists of the menu bar and toolbar for management of the software. 

¶ Menu Bar (Top-most row) 
Contains standard menus: File, Edit, Tools, Help 
Plus, domain-specific modules: Water Distribution Network Model, Storm Water Management 
Model and Surface Runoff Model 

¶ Toolbar (Below Menu Bar) 
This area of the Main Menu Area provides quick-access icons for key operations depending on the 
choice of the selected menu. 
 

 Layer Control Panel (Left Pane) 
 
This is an area that controls the layers that performs functions such as switching layers on and off or 
importing or exporting layers. 

¶ Import / Export / Table to assist in managing GIS layers 

¶ Layer List displays all loaded spatial layers with their EPSG coordinate system. 

¶ Users can toggle visibility, manage attributes, or apply symbology here. 
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 Map Viewer (Right Pane) 
 
2D / 3D tabs allowing user to toggle between 2D and 3D spatial views. 

¶ Navigation tools such as Pan, zoom, select, and edit features. 

¶ Displays the visual representation of the imported GIS data.  
 

 Time Control Area (Bottom-Left) 
 
Used for simulations involving time (Extended Period Simulations) (e.g., events, animations). 
Controls include play, pause, stop, and time step navigation.  
 

 Status Bar (Bottom-Right) 
 
This area shows the current coordinates, scale, expiration date 

¶ Working Mode (e.g., Select, Edit) 

¶ Click XY (cursor coordinate tracking) 

¶ Scale and Map EPSG (projection and zoom control) 
This provides real-time feedback on spatial positioning and tool status.  
 
File menu 
The File menu contains commands for opening and saving data files and for setting the preferred 
language. The commands for the File menu are shown in Figure 7-2 below. It also shows a list of 
recently worked on projects. 
 

 
Figure 7-2: File menu 

 

¶ New Project - Creates a new GISpipe project (file extension *.pgp) 

¶ Open Project - Opens an existing project 

¶ Save Project - Saves the current project 

¶ Save Project As - Saves the current project under a different name 

¶ Language - Set the language to preferred language (English or Korean) 
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Edit menu 
Selecting the Edit menu will show the relevant toolbar which depends on what type of layer the user 
is working on i.e., the screen GUI changes according to the selected layer. 
 
When the selection is on a layer (other than Water Distribution Network Model, Storm Water 
Management Model or Surface Runoff Model) the toolbar options that will be available are as shown 
in Figure 7-3. 
 

 
Figure 7-3: Edit toolbar options 

 

¶ Add Shape - Simply select the layer on which a shape wants to be placed, press the 
Add Shape button, and add the shape to the map.  For a line or polygon, 
click right mouse button to finish. Pressing the ESC key while adding, 
the drawing is cancelled. 

¶ Edit Vertices - Click the Edit Vertices button and select a shape to edit on the map. It 
will change to a dotted line and the shape can be changed by moving 
the green dot. 
Clicking the green dot removes the clicked vertex and clicking between 
the solid lines adds the vertex. 

¶ Split Pipe  -  A function to divide a pipe. 

¶ Transforms - Moving of axis or scales. 

¶ Remove Shapes  -  This function removes selected shapes. 
 
Water Distribution Network Model 
When working on the Water Distribution Network Model selecting Edit menu will show the editing 
functions associated with the water distribution model as shown in Figure 7-4. 
 

 
Figure 7-4: Water Distribution Network Model edit functions 

 
These functions are described in more detail in Section 9.2. 
 
Storm Water Management Model  
When working on the Storm Water Management Model selecting Edit menu will show the editing 
functions associated with the storm water management model as shown in Figure 7-5. 
 

 
Figure 7-5: Storm Water Management Model edit functions 

 
These functions are described in more detail in Section 10.4. 
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Surface Runoff Model 
When working on the Surface Runoff Model selecting Edit menu will show the editing functions 
associated with the surface runoff model as shown in Figure 7-6. 
 

 
Figure 7-6: Surface Runoff Model edit functions 

 
These functions are described in more detail in Section 11. 
 
Water Distribution Network Model menu 
When working on Water Distribution Network Models selecting Water Distribution Network Model 
Menu will show the analysis and viewing functions associated with the water distribution model as 
shown in Figure 7-4. 
 

 
Figure 7-7: Tool bar options when selecting the Water Distribution Network Model Menu 

 
These analyses and viewing functions are described in more detail in Section 9. 
 
Storm Water Management Model menu 
When working on Storm Water Management Models selecting Storm Water Management Model 
Menu will show the analysis and viewing functions associated with the water distribution model as 
shown in Figure 7-8. 
 

 
Figure 7-8: Tool bar options when selecting the Storm Water Management Model Menu 

 
These analyses and viewing functions are described in more detail in Sections 10.6 and 10.6. 
 
Surface Runoff Model menu 
When working on Surface Runoff Models selecting Surface Runoff Model Menu will show the analysis 
and viewing functions associated with the surface runoff model as shown in Figure 7-8. 
 

 
Figure 7-9: Tool bar options when selecting the Surface Runoff Model Menu 

 
These analyses and viewing functions are described in more detail in Section 11. 
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Tools menu 
Selecting the Tools menu will provide the user with specific tools related to the DEM data, Shapefiles 
and generating of basins or streams as shown in Figure 7-10. 
 

 
Figure 7-10: Tool bar options when selecting the Tools Menu 

 
Help menu 
Selecting the Help menu will provide the user with toolbar options related to the use of the software 
as well as the licensing thereof as shown in Figure 7-11. 
 

 
Figure 7-11: Help menu tool bar options 

 

Clicking the Options toolbar button , provides the user with a set of preference that can be set as 
shown in Figure 7-12. The options relate to what the user preference is for scrolling with the mouse, 
the setting of Auto length on or off, cursor, map background colour and keyboard short cut keys. 
 

 
Figure 7-12: Options screen 
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8 GRAPHICAL INFORMATION SYSTEM 

8.1 What is a Geographic Information System (GIS)? 

A Geographic Information System (GIS) is a tool that allows users to collect, manage, analyse, and 
display spatial or geographic data. In the context of GISpipe, GIS is fundamental for creating and 
working with water distribution networks and stormwater systems that are geographically referenced. 
It links data to a specific location, whether a pipe junction, reservoir, valve, catch basin, or terrain 
feature, allowing users to visualize and analyse how infrastructure interacts with the environment. 
 
In water-related modelling, most spatial data, such as pipe routes, ground elevation, land use, rainfall 
zones, and service boundaries, have a geographic component. GISpipe uses this data to enable tasks 
such as locating leaking pipelines, assessing stormwater flow paths, sizing detention basins, or 
planning upgrades to distribution systems. For example, a GIS layer showing high-resolution elevation 
data can be combined with vector-based storm drain networks to identify flow accumulation zones or 
undersized culverts. 
 
GIS technology allows all these different 
types of information, raster data like digital 
elevation models (DEMs), and vector data like 
pipelines and land parcels, to be overlaid on 
top of one another on a single map. By 
treating location as the key index variable, 
GISpipe enables users to perform advanced 
spatial analysis, such as calculating pressure 
zones, estimating runoff contributions from 
impervious surfaces, or assessing the 
hydraulic connectivity between subsystems. 
 
GIS goes far beyond just mapping. It serves as 
a system of record, integrates data from 
diverse sources, enables rich spatial analysis, 
and facilitates data communication through 
intuitive visualizations such as thematic maps 
and dashboards.  

 
These capabilities make GIS an indispensable tool in hydrology, environmental engineering, 
stormwater management, and municipal water services. 
 

8.2 Coordinate Systems 

Accurate spatial representation in GISpipe depends on the correct use of coordinate systems. A 
coordinate system proǾƛŘŜǎ ŀ ŦǊŀƳŜǿƻǊƪ ŦƻǊ ŘŜŦƛƴƛƴƎ ƭƻŎŀǘƛƻƴǎ ƻƴ ǘƘŜ 9ŀǊǘƘΩǎ ǎǳǊŦŀŎŜ ŀƴŘ ƛǎ 
fundamental to integrating and analysing spatial data. 
 
At a broad level, there are two main types of coordinate systems used in GIS: 

¶ Geographic Coordinate Systems (GCS) - These define locations using a spherical model of the 
Earth, typically in degrees of latitude and longitude. 

¶ Projected Coordinate Systems (PCS) - ¢ƘŜǎŜ ϦŦƭŀǘǘŜƴϦ ǘƘŜ 9ŀǊǘƘΩǎ ǎǳǊŦŀŎŜ ƻƴǘƻ ŀ ǘǿƻ-
dimensional plane, using mathematical transformations to express positions in linear units 
such as meters. This is essential for engineering design and spatial analysis. 
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GISpipe allows the user to select and specify the coordinate system of any layer (Figure 8-1). 
 

 
Figure 8-1: Coordinate System 

 

8.3 Understanding Map Projections 

To represent the Earth's curved surface on a flat map or screen, a mathematical transformation called 
a map projection is required. All map projections introduce some distortion, whether of area, distance, 
shape, or direction. Selecting the correct projection is critical in GISpipe to ensure spatial accuracy, 
especially for tasks like calculating pipe lengths, analysing flow directions, or determining catchment 
boundaries. 
 
Some projections, like the Mercator, are useful for navigation because they preserve direction, but 
they distort area, particularly near the poles. Others, like equal-area or equidistant projections, 
preserve area or distances along specific lines but may distort shape. For localized hydraulic or 
engineering modelling, Transverse Mercator projections are often preferred because they minimize 
distortion over small regions. 
Selecting an appropriate projection is critical for ensuring spatial accuracy, especially in hydraulic 
modelling tasks such as pipe length calculations, catchment analysis, or flow direction assessment. 
 
 



 

GISpipe ς User manual 17 

For example: 

¶ The Mercator projection preserves direction but significantly distorts area near the poles. 

¶ Equal-area projections maintain true area relationships, making them suitable for land use 
analysis. 

¶ Transverse Mercator projections minimize distortion in small regions and are commonly used 
for engineering and cadastral mapping. 
 

GISpipe supports projection-aware workflows and provides tools for assigning and transforming 
coordinate systems of spatial layers. This is particularly important when integrating data from multiple 
sources or conducting precise hydraulic simulations. For example, a terrain dataset in a projected CRS 
can be aligned with a pipeline network in another CRS using built-in transformation tools. 
 
In South Africa, the modern standard is the Hartebeesthoek94 (HB94) coordinate system, based on 
the WGS84 ellipsoid. It is divided into 2-degree longitude zones with corresponding EPSG codes (e.g., 
EPSG:2053 for Lo29). Accurate CRS selection ensures that all components of a model, e.g., pipe 
alignments, terrain elevations, and rainfall catchment, fit together seamlessly. 
 
When combining spatial data from multiple sources, such as survey drawings, satellite imagery, and 
scanned topographic maps, differences in their underlying coordinate systems and projections can 
cause misalignment. GIS software addresses this by reprojecting layers to a common coordinate 
system, ensuring spatial consistency. 
 
This process is essential for water distribution modelling in GISpipe, where overlaying layers such as 
elevation (from DEMs), pipe networks (vector), and land use zoning must align precisely for accurate 
analysis. 
 

8.4 Spatial Data Formats, Capturing and Scales 

GIS data is generally stored in two primary formats: 
 

¶ Raster - Gridded data made up of cells or pixels. Commonly used for continuous data like 
elevation, land cover, or temperature. 

¶ Vector - Uses discrete geometries, points, lines, and polygons, to represent features like 
junctions, pipelines, tanks, and pressure zones. 

 
Regardless of format, spatial datasets must be georeferencedτlinked to a coordinate systemτto 
ensure spatial consistency and enable meaningful analysis. 
 
Incorporating data into GIS involves data capture. Native digital datasets (e.g., GPS, shapefiles, CAD 
drawings) can be directly imported. Analogue sources, such as paper maps or scanned plans, require 
digitising and georeferencing before use. Proper scale management is also crucial. Scale refers to the 
Ǌŀǘƛƻ ōŜǘǿŜŜƴ ŀ ƳŀǇΩǎ ŘƛǎǘŀƴŎŜ ŀƴŘ ǘƘŜ ŀŎǘǳŀƭ ground distance. In engineering workflows, maintaining 
consistent scale ensures reliable measurements, particularly when assessing distances, elevations, or 
hydraulic gradients. 
 
GISpipe facilitates consistent data integration through coordinate system management, scale control, 
and projection handling, enabling engineers to build robust, accurate hydraulic models and carry out 
effective spatial analysis for water infrastructure planning and design. 
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9 WATER DISTRIBUTION NETWORK MODEL 

A typical GISpipe modelling workflow for a water distribution network model includes the following 
steps: 
 

  Create or import base layers (pipes, junctions, reservoirs, tanks) 
 

This step involves setting up the foundational components of the network 
either manually or by importing from external GIS, CAD, or database files. 
Accurate spatial and structural representation at this stage ensures that 
the network topology is valid and complete. 

 
  

 Assign attributes such as elevation, diameter, demand, and status 
 

Each network element must be defined with hydraulic and operational 
parameters to reflect real-world conditions. This includes node elevations, 
pipe diameters, expected demand at junctions, and operational status 
(open/closed) of valves and pumps. 

 
  

 Edit and validate the network using map tools and tables 
 

Visual editing allows users to reposition elements and correct connectivity 
or attribute errors using a map-based interface. Validation tools then 
check for data inconsistencies such as unconnected nodes, zero-length 
pipes, or missing attributes. 

 
  

 Set simulation parameters, including time patterns and controls 
 

Simulation settings such as duration, hydraulic time steps, and water 
quality parameters are configured in this step. Control rules and time 
patterns (e.g., diurnal demand curves or pump schedules) are also 
assigned to reflect temporal variations. 

 
  

 Run the simulation (hydraulic or water quality using the EPANET 
engine) 

 

The hydraulic and/or water quality simulation is executed using EPANET's 
solver. It computes flow rates, pressures, tank levels, and concentrations 
across the network over time using iterative numerical techniques like the 
Gradient Algorithm  
  

 View results graphically (e.g., contours, graphs, tables) 
 

Post-processing tools enable the analysis of results using colour-coded 
contours, interactive graphs, and summary tables. These visualizations 
help identify problem areas such as low-pressure zones or high-water age 
regions. 

 
  

 Export simulation output or INP files for documentation or further 
analysis 

 

The results and model configuration can be saved or exported in standard 
formats (e.g., *.INP, *.PGP, *.CSV) for reporting or sharing with other 
software programs. This ensures reproducibility, and supports 
collaborative workflows.  
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9.1 Hydraulic and quality analysis model 

9.1.1 Hydraulic Simulation Model 

DL{ǇƛǇŜ ǳǘƛƭƛǎŜǎ 9t!b9¢Ωǎ ƘȅŘǊŀǳƭƛŎ ǎƛƳǳƭŀǘƛƻƴ ƳƻŘŜƭ ǿƘƛŎƘ ŎƻƳǇǳǘŜǎ ƧǳƴŎǘƛƻƴ ƘŜŀŘǎ ŀƴŘ ƭƛƴƪ Ŧƭƻǿǎ 
for a fixed set of reservoir levels, tank levels, and water demands over a succession of points in time. 
From one time step to the next reservoir levels and junction demands are updated according to their 
prescribed time patterns while tank levels are updated using the current flow solution. The solution 
for heads and flows at a particular point in time involves solving simultaneously the conservation of 
flow equation for each junction and the headloss relationship across each link in the network. 
 
¢Ƙƛǎ ǇǊƻŎŜǎǎΣ ƪƴƻǿƴ ŀǎ άƘȅŘǊŀǳƭƛŎŀƭƭȅ ōŀƭŀƴŎƛƴƎέ ǘƘŜ ƴŜǘǿƻǊƪΣ requires using an iterative technique to 
ǎƻƭǾŜ ǘƘŜ ƴƻƴƭƛƴŜŀǊ Ŝǉǳŀǘƛƻƴǎ ƛƴǾƻƭǾŜŘΦ 9t!b9¢ ŜƳǇƭƻȅǎ ǘƘŜ άDǊŀŘƛŜƴǘ !ƭƎƻǊƛǘƘƳέ ŦƻǊ ǘƘƛǎ ǇǳǊǇƻǎŜΦ  
The hydraulic time step used for extended period simulation (EPS) can be set by the user. A typical 
value is 1 hour. Shorter time steps than normal will occur automatically whenever one of the following 
events occurs: 

¶ The next output reporting time period occurs 

¶ The next time pattern period occurs 

¶ A tank becomes empty or full 

¶ A simple control or rule-based control is activated 
 
9.1.2 Water Quality Simulation Model 

Basic transport 
 
GISpipe utilises the water quality engine of EPANET which uses a Lagrangian time-based method to 
simulate how discrete parcels of water move and mix through the pipe network. Each pipe is filled 
with a series of non-overlapping segments whose quality is updated at every water quality time step. 
These steps are shorter than hydraulic steps to capture dynamic behaviour, and involve applying 
reactions, updating mass balances at nodes, and creating new segments when inflow concentrations 
change significantly. Flow reversals are handled by reordering segments, and water quality at nodes 
is computed based on cumulative inflow from all contributing segments. 
 
Mixing in storage tanks 
 
GISpipe utilises the water quality engine of EPANET which provides four tank mixing models: 

¶ Complete Mixing ς Assumes instant and uniform mixing throughout the tank. 

¶ Two-Compartment Mixing ς Splits the tank into two completely mixed zones to simulate 
short-circuiting and dead zones. 

¶ FIFO Plug Flow ς Assumes water flows in and out in the same order, like a pipeline; no mixing 
occurs. 

¶ LIFO Plug Flow ς Water enters and exits from the bottom in reverse order; useful for 
standpipes. 

 
These models allow flexibility to represent various physical tank behaviours more accurately. 
 
Water quality reactions 
 
Reactions can occur in the bulk flow or along the pipe wall: 

¶ Bulk Reactions follow nth order kinetics and can include growth, decay, or reactions with 
limiting concentrations. GISpipe allows users to input the rate coefficient, reaction order, and 
limiting concentration as needed. 
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¶ Wall Reactions depend on the concentration in the bulk and the surface-to-volume ratio of 
the pipe. Reaction rates can be zero- or first-order and are influenced by pipe roughness, 
ƳŀǘŜǊƛŀƭΣ ŀƴŘ ŀƎŜΦ ¢ƘŜ ǿŀƭƭ ǊŜŀŎǘƛƻƴ ŎƻŜŦŦƛŎƛŜƴǘǎ Ŏŀƴ ōŜ ǊŜƭŀǘŜŘ ǘƻ ǘƘŜ ǇƛǇŜΩǎ ƘŜŀŘ ƭƻǎǎ 
characteristics using empirical relationships. 

 
Water age and source tracing 
 
Water age is modelled as a zero-order growth process, where each second adds one second to the 
age of water, providing a general indicator of water freshness. For source tracing, the model tracks 
the proportion of water at each node originating from a designated source, treated as a 100% 
concentration of a non-reactive constituent. This helps evaluate blending patterns and source 
contributions throughout the network over time. 

 
9.2 Building a Water Network Model 

This section outlines the step-by-step process for constructing a hydraulic water distribution network 
within GISpipe, from establishing the base layout to configuring simulation parameters for accurate 
system analysis. 
 
9.2.1 Working with Layers 

GISpipe offers robust layer management tools to support hydraulic, stormwater, and runoff modelling. 
This section explains how to work with layers, including importing data, assigning coordinate systems, 
managing geometry, and accessing layer-specific properties. 
 
Importing Layers and Data 
 
When starting a new project, users can either: 

¶ Digitize features manually using map-based drawing tools, or 

¶ Import existing GIS datasets, such as: 
o Shapefiles (.shp) 
o GeoJSON (.geojson) 
o CSV files with coordinate columns 
o Raster files for DEMs (e.g., .tif) 
o INP files for EPANET or SWMM network import 

See Appendix A for a list of supported formats 

¶ To import a shapefile, navigate to the Layer Control Panel (left pane) and click on the Import 

button, . 

¶ Select and open the file and choose the geometry type (Waterworks, Sewer or Other), as 
shown in Figure 9-1. 

¶ Assign it to a GISpipe object category (e.g., Junctions, Pipes, Sewer Lines, etc.). 

¶ Define field mappings such as diameter, elevation, or roughness. 
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Figure 9-1: Mapping field type selection 

 
Layer Types and Geometry 
 
Each object type has a predefined geometry: 
 
Table 9-1: Layer types and geometry 

Layer Geometry Description 

Junctions Point Model demand points and connection nodes 

Reservoirs Point Represents fixed-head sources 

Tanks Point Model storage with variable water level 

Pipes Line Convey water between nodes 

Pumps/Valves Line Represent special hydraulic links 

Labels Point Optional annotation layer 

Catchments Polygon Used in stormwater and runoff models 

Streams/Basins Line/Poly For DEM and terrain-based analysis 

SWMM Elements Various Sewer elements like manholes and laterals 

Background Maps Raster Google Maps, Bing, OpenStreetMap 
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Layer Toolbar Functions 
 
Icons at the top of the layer panel, as shown in Figure 9-2, provides various functionalities, as listed in  
Table 9-2 to integrate different layers into the project. 
 

 
Figure 9-2: Layer toolbar 

 
Table 9-2: Layer toolbar functions 

Option Description 

 Import Add shapefiles, INP files, raster data and many other file formats. A list of 
the different files that can be imported is provided in Appendix A. 

 Export  Depending on the selected layer type, the layer can be exported to the 
following file formats. 

¶ Water network: EPAnet 2 INP, EPAnet 2 NET, EPAnet 3 INP, Shapefile 
(see Figure 9-3) and DXF 

¶ Stormwater/Sewer network: SWMM INP and Shapefile 

¶ Any other (polygon, line, point, subcatchment, DMA, Water meter etc.): 
Shapefile  

 Table View and edit values in the attribute tables see Figure 9-4. 

 Add Add a new layer. Various options will be provided as depicted in Figure 9-5. 

 Delete Delete the selected layer from the map. 

 Move up Move selected layer up in the display order. 

 Move down Move selected layer down in the display order. 

 Visibility toggle Enable or disable a layer's visibility. 

 

 
Figure 9-3: Exporting to shape file (example of water network) 

 
As an example, the user has options of the information of the components of a water distribution 
network that should be included in the compiled shape file see Figure 9-3. 
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Figure 9-4: Attribute table 

 

  

  
Figure 9-5: Adding of layers (Background, Waterworks, Sewerage, Others) 
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Attribute Tables and Data Extraction 
 
Each vector layer can be opened in a tabular view where there are functionalities (Figure 9-6), where 
users can: 

¶ View, filter, and group data 

¶ Edit values (e.g., elevation, demand, roughness) 

¶ Export to Excel or CSV 

¶ Perform batch input or batch editing 

¶ Use tools such as DMA Mapping, Valve ID assignment, or Contour tagging. 

The attribute table can be viewed by clicking on the Table button on the Layer toolbar. 
 

 
Figure 9-6: Attribute table functionalities 

 
Creating New Layers 
 

Users can create new editable layers by clicking on the Add button  on the Layer toolbar. Various 
options will be available on 4 different tabs as depicted in Figure 9-5 
 
Tabs: 

¶ Background: Add base maps like Google Maps, Bing Map or Open Street Map. 

¶ Waterworks (EPANET layers): A new EPANET network layer with junctions, pipes, tanks, valves, 
meters, etc., or specific layers related to the water network model such as Water Meter, Flow 
gauges etc. 

¶ Sewerage (SWMM layers): A new SWMM network with junctions, outfalls, conduits, weirs etc., 
or specific layers such as Main/Lateral sewers, manholes, subcatchments etc. 

¶ Others: Generic vector types like Points, LineStrings and Polygons. 
 
Click the Add Layer button to include the new layer in your workspace. 
 
Layer Context Menu Options 
 
Right-clicking on a layer opens the context menu as depicted in Figure 9-7. 
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Figure 9-7: Layers context menu 

 
This enables the user to select features as listed in Table 9-3.  
 
Table 9-3: Layers context menu 

Option Description 

Layer Enable Turn layer visibility on/off. 

Layer Properties Open a dialog with detailed settings (see Table 9-4). 

Specify Coordinate System 5ŜŦƛƴŜ ǘƘŜ ƭŀȅŜǊΩǎ ǇǊƻƧŜŎǘƛƻƴ (see Figure 9-15). 

Coordinate System Transformation Reproject the layer to another EPSG (see Figure 9-16). 

Layer Copy Duplicate the selected layer. 

Layer Remove Delete the layer from the map. 

 
Layer Properties Dialog 
 
The Layer Properties dialog provides key controls such as listed in Table 9-4 and the window shown in 
Figure 9-8.  
 
In the Properties dialog window, the user can also open a saved style such as Thematic Tool Kit 
(*.ttkstyle), Initialization File (*.ini) or Styled Layer Descriptor (*.sld) which are different types of files 
used for storing styling and configuration information. 
 
If a certain style has been set-up by a user this can also be saved (in *.ttkstyle format), for later use in 
other projects. 
 
The parameters which can be changed will depend on the layer type, Raster or Vector or Other type 
off layer. 
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Table 9-4: Layer property settings 

Option Description 

General Tab 

Parameters  

 Caption The display name or title of the layer as it appears in the map 
legend or layer list. See Figure 9-8. 

 Coordinate system Specifies the spatial reference system (SRS) or projection used by 
the layer, such as WGS 84, UTM Zone 35S, or EPSG:4326. This 
ensures that the layer aligns properly with other spatial data and 
maps. If the coordinate system is incorrect or missing, features 
may appear in the wrong location or not at all. 

Painting (see Figure 9-8)  

 Base map Specifies whether the layer serves as a base map (i.e., a 
background reference layer like satellite imagery or terrain). Base 
maps render beneath operational layers and are not interactive.  

 Cached paint Enables or disables the use of a cached (pre-rendered) version of 
the layer for display. This improves rendering performance by 
avoiding re-drawing the layer each time the view changes. 

 Ignore shape parameters When enabled, the software disregards shape-specific properties 
such as size, orientation, or border styling defined in the data. This 
is useful when a consistent or simplified rendering style is desired 
across all features, regardless of individual geometry attributes. 

 Multipass rendering 
(slower) 

Allows the use of multiple rendering passes for complex 
symbology (e.g., layering shadows, outlines, gradients). It 
produces high-quality visual effects but may slow down 
performance due to repeated processing. 

 Prefer styling from config 
file 

Prioritizes style settings from an external configuration file 
(e.g., .ttkstyle, .ini, or .sld) over default or manual settings. 
This ensures consistency across projects or environments by 
applying pre-defined styling rules. 

 Transparency Sets the transparency level of the layer (from fully opaque to fully 
transparent) which allows layers beneath to be partially visible, 
enabling better visual integration or overlay comparison. 

 Interpretation 5ŜŦƛƴŜǎ Ƙƻǿ ǘƘŜ ƭŀȅŜǊΩǎ Řŀǘŀ ǎƘƻǳƭŘ ōŜ ƛƴǘŜǊǇǊŜǘŜŘ ƻǊ ǊŜƴŘŜǊŜŘΣ 
such as raster bands, categorical data, or elevation models. 
Options are Default, Pixel or Grid. This guides the software on how 
to handle and display the data meaningfully, based on its type and 
intended use. 

Info  

 File information Displays metadata about the data source file associated with the 
layer, format (e.g., Shapefile, GeoTIFF), size, last modified date, 
and encoding. 

 User comments A free-text field where users can add notes, descriptions, or 
observations related to the layer. This is to provide context, 
documentation, or reminders for future users or collaborators, 
such as data provenance, intended use, limitations, or special 
considerations. 
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Sections Tab 

Visible (see Figure 9-9)  

Sections  

 Section Represents logical groupings or thematic divisions within the 
layer, often used to manage complex datasets with sub-categories 
or to toggle visibility of specific parts of the data. This enables 
better organization and selective display of content within the 
layer, such as grouping features by type, function, or zone. 

 Minimum scale Sets the smallest map scale (i.e., most zoomed out) at which the 
layer or section will be visible. This prevents clutter on the map by 
hiding detailed layers when the user is too zoomed out to see 
them meaningfully. For example, only show hydrants when 
zoomed into neighbourhood level. See Figure 9-9. 

 Maximum scale Sets the largest map scale (i.e., most zoomed in) at which the layer 
or section will be visible. This hides layers when zoomed in too far, 
which can improve performance and relevance. For example, a 
regional water network might disappear when zoomed into street 
level. See Figure 9-9 

3D (see Figure 9-10)  

 Treat Layer as 2D Renders the layer in a flat, two-dimensional view using only X 
(longitude) and Y (latitude) coordinates. This is suitable for most 
thematic and topographic maps where elevation or depth is not 
relevant. Simplifies visualization and improves performance. 

 Treat Layer as 3D Objects Enables three-dimensional rendering of the layer by incorporating 
Z-values (elevation or depth). This is useful for visualizing terrain, 
infrastructure or subsurface networks in 3D scenes. 

 Normalized Z Adjusts all Z-values relative to a base elevation (often ground 
level), converting absolute heights to relative ones. This is useful 
when data contains absolute elevation values but needs to be 
visualized relative to the surface. 

 Scale Z (%) Multiplies all Z-values by a scaling factor (in percent) to enhance 
or compresses vertical exaggeration to improve visual 
interpretation of elevation differences, especially in flat terrain. 

 False Z Assigns an artificial or fixed Z-value to features that lack true 
elevation data which allows non-elevated features (e.g., 2D lines 
or points) to be placed at a desired height in the 3D scene, 
avoiding overlap or hiding. 

Pixel (see Figure 9-11)  

 Colours Defines how pixel values are mapped to display colours, either 
through colour Red, Green, Blue, Brightness, Contrast etc. This 
enhances interpretation by assigning meaningful or visually 
distinct colours to pixel values. 

 Bands Specifies which raster bands (e.g., Red, Green, Blue, Alpha) are 
used for display or analysis. This allows control over image 
composition. Common configurations include: 

 Transparency Adjusts the overall transparency of the raster layer or sets specific 
pixel values to be transparent (e.g., No Data areas). This improves 
map readability by allowing background layers to show through, 
or by hiding irrelevant or missing data areas. 
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Grid (see Figure 9-12)  

 Grid Section 

 Grid Band Selects which raster band to display (Default or 1). Useful for 
multi-band datasets. 

 Shadow Select to add shadow effect to grid rendering for better visual 
depth. 

 Antialiasing Select to smooth out jagged edges in the raster rendering. 

 Minimum / Maximum 
Value 

Defines the data value range to be rendered and visualized. Any 
values outside this range may be clipped 

 Height Threshold 

 Minimum / Maximum 
Value 

Similar to grid min/max, but may be used for visualizing a specific 
elevation band (e.g., for hillshading or analysis thresholds). 

 Ramp 

 Min/Max/Legend Displays and allows editing of value classes and their 
corresponding colour bands. 

 Smooth colours Toggles between a smooth gradient and sharp colour changes 
between classes. 

 Grid Ramp Wizard Options (see Figure 9-13) 

 Simple classification Used for direct linear or continuous scaling between min and max 
values. The user chooses start, middle, and end values for colour 
gradation. 

 Unique values Applies a colour to each unique raster value (used for categorical 
data). 

 Continuous values Applies a gradient scale to a continuous range (e.g., elevation or 
temperature). 

 Minimum/Maximum 
value 

Sets the value range for colour ramping. 

 Use middle value Allows defining a midpoint value for 3-Colour gradient transitions. 

 Start Colour, Middle 
Colour, End Colour 

Define the gradient colours used in the colour ramp. 

 Add new ramp to 
existing ramp 

Combines the new ramp with previously defined ones. 

 Use HSL Enables smoother transition by using Hue-Saturation-Lightness 
colour space. 

 Ramps Choose from predefined palettes (e.g., Autumn, Terrain, 
Greyscale). 

 Reverse Select to reverses the colour ramp. 

 Discrete 
 

Select to display colour classes as distinct bands without gradient 
blending. 

 Show all Select to display all ramp options for selection. 

 Level every Defines spacing between data value contour levels. 

 Legend every Defines spacing between legend labels displayed on the map. 

 Advanced classification Allows more refined control, such as classification methods, 
number of classes, and band selection. 

 Method Determines how the data range is divided. Natural Breaks which 
minimize variance within classes and maximizes variance between 
classes. Other methods may include Equal Interval, Quantile, 
Standard Deviation, etc. 

 Classes Number of colour intervals or groupings to divide the raster data 
into 
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 Interval Automatically calculated based on data range and classification 
method; defines the step size 

 Band For multi-band rasters, select which band to classify (e.g., Band 1 
= elevation in DEM). 

 Start Colour, Middle 
Colour, End Colour 

Define the gradient colours used in the colour ramp. 

 Add new ramp to 
existing ramp 

Combines the new ramp with previously defined ones. 

 Use HSL Enables smoother transition by using Hue-Saturation-Lightness 
colour space. 

 Ramps Choose from predefined palettes (e.g., Autumn, Terrain, 
Greyscale). 

 Reverse Select to reverses the colour ramp. 

 Discrete Select to display colour classes as distinct bands without gradient 
blending. 

 Show all Select to display all ramp options for selection. 

 Statistics Calculation ς 
Fast Scan 

Quickly estimates the raster stats (min/max, etc.). Faster, but less 
accurate. 

 Statistics Calculation ς 
Full Scan 

Scans the entire raster for precise statistics. Slower, but 
recommended for accurate classification. 

 

 
Figure 9-8: Layer properties 
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Figure 9-9: Layer properties - Visible settings 

 

 
Figure 9-10: Layer property ς Visible (3D) settings 
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Figure 9-11: Layer property ς Visible (Pixel) settings 
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Figure 9-12: Layer property ς Visible (Grid) settings 
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Figure 9-13: Layer property ς Visible (Grid) settings ς Wizard (Simple Classification) 

 

  
  

  
Figure 9-14: Layer property ς Visible (Grid) settings ς Wizard (Advanced Classification) 
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These tools help users visually classify and interpret raster data (e.g., elevation, runoff), and customize 
how information is displayed in GISpipe. 
 
Coordinate System Settings 
 
When working with spatial data in GISpipe, it is essential to assign the correct coordinate reference 
system (CRS) to ensure accurate alignment, measurements, and spatial analysis. The coordinate 
system defines how geographic coordinates are projected onto a flat surface. 
 
To specify the coordinate system of a layer, right click on a layer to show the Layers context menu 
(Figure 9-7). 
 
Left click on the Specify Coordinate System option to show the Select Coordinate System window 
(Figure 9-15) where the EPSG code for a newly imported layer (e.g., EPSG:3857 for Web Mercator, 
EPSG:32735 for WGS 84 UTM Zone 35S) can be set (Table 9-5). 
 

 
Figure 9-15: Coordinate System 
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Table 9-5: Coordinate System 

Parameter Description 

EPSG A unique identifier for the coordinate system. 

Coordinate System Typically includes the datum and the specific projection zone 

Unit Measurement unit (e.g., meters). 

 
Steps to select the correct CRS 

1. Identify the geographic region 

¶ In this case, a project located in South Africa is highlighted on the map. 

¶ A user can search for a country to narrow down the search for the most appropriate CRS 
system to select. 

 
2. Choose the appropriate CRS 

 

¶ For South Africa, the recommended modern coordinate system is Hartebeesthoek94 
(HB94), based on the WGS84 ellipsoid. 

¶ This system is split into Lo (Longitude) zones spaced every 2 degrees. Example zones: 
 

o Lo19 (EPSG:2051) for areas around 19°E 
o Lo29 (EPSG:2053) for areas around 29°E 
o Lo31 (EPSG:2054) for areas around 31°E, etc. 

 
3. Match zone with project location 

 

¶ Find the longitude of your project site and select the corresponding HB94 / Lo zone. For 
example: 

o If your site is located at ~29°E longitude, use Hartebeesthoek94 / Lo29 
(EPSG:2053). 

o If it is located at ~31°E, choose Lo31 (EPSG:2054). 
 

4. Legacy systems 
 

¶ Older coordinate systems such as Cape / Lo (EPSG:22277 or EPSG:4222) may still appear. 
These are not recommended unless legacy data compatibility is required. 

 
5. Final selection 

 

¶ Click the desired row (e.g., EPSG:2053 for HB94 / Lo29). 

¶ Click OK button to apply the coordinate system. 
 
Tip: Click the View on map button to visually confirm the coverage of each CRS zone, aiding in the 
correct selection based on geographic location. 
 
Coordinate System Transformation 
 
Convert a layer from one CRS to another using a transformation dialog box (e.g., from 3857 to 32735). 
 
To transform the coordinate system of a layer, right click on a layer to show the Layers context menu 
(Figure 9-7). 
 
The Coordinate System Transformation window will be displayed as shown in Figure 9-16. 
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Figure 9-16: Coordinate System Transformation 

 
The current Source EPSG is displayed and the Target ESPG can be entered in the input box or selected 
by clicking on the ellipse όΧύ ǘƻ ǘƘŜ ǊƛƎƘǘ ƻŦ ǘƘŜ ƛƴǇǳǘ ōƻȄ ǘƻ ǎƘƻǿ ǘƘŜ {ŜƭŜŎǘ /ƻƻǊŘƛƴŀǘŜ {ȅǎǘŜƳ ǿƛƴŘƻǿ 
(Figure 9-15). 
 
9.2.2 Physical components 

GISpipe models a water distribution system as a collection of links connected to nodes. The links 
represent pipes, pumps, and control valves. The nodes represent junctions, tanks, and reservoirs. 
Figure 9-17 below illustrates how these objects can be connected to one another to form a network. 
 

 
Figure 9-17: Components 

 
Junctions 
 
Junctions are points in the network where links join together and where water enters or leaves the 
network. The basic input data required for junctions are: 

¶ Elevation above some reference (usually mean sea level) 

¶ Water demand (rate of withdrawal from the network) 

¶ Initial water quality 
 
The output results computed for junctions at all time periods of a simulation are: 

¶ Hydraulic head (internal energy per unit weight of fluid) 

¶ Pressure 

¶ Water quality 
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Junctions can also: 

¶ Have their demand vary with time 

¶ Have multiple categories of demands assigned to them 

¶ Have negative demands indicating that water is entering the network 

¶ Have pressure driven demand 

¶ Be water quality sources where constituents enter the network 

¶ Contain emitters (or sprinklers) which make the outflow rate depend on the pressure 
 
Reservoirs 
 
Reservoirs are nodes that represent an infinite external source or sink of water to the network. They 
are used to model such things as lakes, rivers, groundwater aquifers, and tie-ins to other systems. 
Reservoirs can also serve as water quality source points. The primary input properties for a reservoir 
are its hydraulic head (equal to the water surface elevation if the reservoir is not under pressure) and 
its initial quality for water quality analysis. Because a reservoir is a boundary point to a network, its 
head and water quality cannot be affected by what happens within the network. Therefore, it has no 
computed output properties. However, its head can be made to vary with time by assigning a time 
pattern to it (see Section 9.2.6). 
 
Tanks 
 
Tanks are nodes with storage capacity, where the volume of stored water can vary with time during a 
simulation. The primary input properties for tanks are: 

¶ Bottom elevation (where water level is zero) 

¶ Diameter (or shape if non-cylindrical ) 

¶ Initial, minimum and maximum water levels 

¶ Initial water quality 
 
The principal outputs computed over time are: 

¶ Hydraulic head (water surface elevation) 

¶ Water quality 
 
Tanks are required to operate within their minimum and maximum levels. GISpipe stops outflow if a 
tank is at its minimum level and stops inflow if it is at its maximum level. Tanks can also serve as water 
quality source points. 
 
Emitters 
 
Emitters are devices associated with junctions that model the flow through a nozzle or orifice that 
discharges to the atmosphere. The flow rate through the emitter varies as a function of the pressure 
available at the node. Emitters are used to model flow through sprinkler systems and irrigation 
networks. They can also be used to simulate leakage in a pipe connected to the junction (if a discharge 
coefficient and pressure exponent for the leaking crack or joint can be estimated) or compute a fire 
flow at the junction (the flow available at some minimum residual pressure). 
 
In the latter case one would use a very high value of the discharge coefficient (e.g., 100 times the 
maximum flow expected) ŀƴŘ ƳƻŘƛŦȅ ǘƘŜ ƧǳƴŎǘƛƻƴΩǎ ŜƭŜǾŀǘƛƻƴ ǘƻ ƛƴŎƭǳŘŜ ǘƘŜ ŜǉǳƛǾŀƭŜƴǘ ƘŜŀŘ ƻŦ ǘƘŜ 
pressure target. GISpipe treats emitters as a property of a junction and not as a separate network 
component. 
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Note: The pressure-flow relation at a junction defined by an emitter should not be confused with the 
pressure demand relation when performing a pressure driven analysis (PDA).  
 
Pipes 
 
Pipes are links that convey water from one point in the network to another. GISpipe assumes that all 
pipes are full at all times. Flow direction is from the end at higher hydraulic head (internal energy per 
weight of water) to that at lower head. The principal hydraulic input parameters for pipes are: 

¶ Start and end nodes 

¶ Diameter 

¶ Length 

¶ Roughness coefficient (for determining headloss) 

¶ Minor headloss coefficient 

¶ Status (open, closed, or contains a check valve) 
 
The status parameter allows pipes to implicitly contain shutoff (gate) valves and check (non-return) 
valves (which allow flow in only one direction). 
 
The water quality inputs for pipes consist of: 

¶ Bulk reaction coefficient 

¶ Wall reaction coefficient 
 
Computed outputs for pipes include: 

¶ Flow rate 

¶ Velocity 

¶ Headloss 

¶ Darcy-Weisbach friction factor 

¶ Average reaction rate (over the pipe length) 

¶ Average water quality (over the pipe length) 
 
The hydraulic head lost by water flowing in a pipe due to friction with the pipe walls can be computed 
using one of three different formulas: 

¶ Hazen-Williams formula 

¶ Darcy-Weisbach formula 

¶ Chezy-Manning formula 
 
The Hazen-Williams formula is the most commonly used headloss formula in the United States. It 
cannot be used for liquids other than water and was originally developed for turbulent flow only. The 
Darcy-Weisbach formula is the most theoretically correct. It applies over all flow regimes and to all 
liquids. The Chezy-Manning formula is more commonly used for open channel flow. Each formula uses 
a different pipe roughness coefficient that must be determined empirically.  With the Darcy-Weisbach 
formula GISpipe uses different methods to compute the friction factor depending on the flow regime: 

¶ HagenςPoiseuille formula is used for laminar flow (Re < 2 000). 

¶ Swamee and Jain approximation to the Colebrook-White equation is used for fully turbulent 
flow (Re >4 000). 

¶ Cubic interpolation from the Moody Diagram is used for transitional flow (2 000 < Re < 4 000). 
 
Pipes can be set open or closed at pre-set times or when specific conditions exist, such as when tank 
levels fall below or above certain set points, or when nodal pressures fall below or above certain values. 
See the discussion of Controls in Section 9.2.6. 
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Minor head losses (also called local losses) are caused by the added turbulence that occurs at bends 
and fittings. The importance of including such losses depends on the layout of the network and the 
degree of accuracy required. They can be accounted for by assigning the pipe a minor loss coefficient.  
 
Pumps 
 
Pumps are links that impart energy to a fluid thereby raising its hydraulic head. The principal input 
parameters for a pump are its start and end nodes and its pump curve (the combination of heads and 
flows that the pump can produce). In lieu of a pump curve, the pump could be represented as a 
constant energy device, one that supplies a constant amount of energy to the fluid for all combinations 
of flow and head. The principal output parameters are flow and head gain. Flow through a pump is 
unidirectional and GISpipe will not allow a pump to operate outside the range of its pump curve. 
 
Variable speed pumps can also be considered by specifying that their speed setting be changed under 
these same types of conditions. By definition, the original pump curve supplied to the program has a 
relative speed setting of 1. If the pump speed doubles, then the relative setting would be 2; if run at 
half speed, the relative setting is 0.5 and so on. Changing the pump speed shifts the position and shape 
of the pump curve. 
 
As with pipes, pumps can be turned on and off at pre-set times or when certain conditions exist in the 
ƴŜǘǿƻǊƪΦ ! ǇǳƳǇΩǎ ƻǇŜǊŀǘƛƻƴ Ŏan also be described by assigning it a time pattern of relative speed 
settings. GISpipe can also compute the energy consumption and cost of a pump. Each pump can be 
assigned an efficiency curve and schedule of energy prices. If these are not supplied then a set of 
global energy options will be used. 
 
Flow through a pump is unidirectional. If system conditions require more head than the pump can 
produce, GISpipe shuts the pump off. If more than the maximum flow is required, GISpipe extrapolates 
the pump curve to the required flow, even if this produces a negative head. In both cases a warning 
message will be issued. 
 
Valves 
 
Valves are links that limit the pressure or flow at a specific point in the network. Their principal input 
parameters include: 

¶ Start and end nodes 

¶ Diameter 

¶ Setting 

¶ Status 
 
The computed outputs for a valve are flow rate and headloss. The different types of valves included 
in GISpipe are listed in Table 9-6. 
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Table 9-6: Types of valves 

Valve type Description Image 

Isolating Valve (IV) IVs (ball, butterfly, gate) is simulated by a 
setting in the Initial Status property of a pipe. 
It can be either completely open or closed and 
are not considered as separate valve links. 

 

 
 

Check Valve (CV) CVs (non-return, one-way) is simulated by a 
setting in the Initial Status property of a pipe. 
Select Check Valve if to ensure the fluid can 
only flow in one direction. CVs are not 
considered as separate valve links. 

 

 
 

Pressure Reducing 
Valve (PRV) 

PRVs limit the pressure at a point in the pipe 
network. GISpipe computes in which of three 
different states a PRV can be in: 

¶ Partially opened (i.e., active) to achieve its 
pressure setting on its downstream side 
when the upstream pressure is above the 
setting 

¶ Fully open if the upstream pressure is 
below the setting 

¶ Closed if the pressure on the downstream 
side exceeds that on the upstream side 
(i.e., reverse flow is not allowed) 

 

Pressure Sustaining 
Valve (PSV) 

PSVs maintain a set pressure at a specific point 
in the pipe network. GISpipe computes in 
which of three different states a PSV can be in: 

¶ Partially opened (i.e., active) to maintain 
its pressure setting on its upstream side 
when the downstream pressure is below 
this value 

¶ Fully open if the downstream pressure is 
above the setting 

¶ Closed if the pressure on the downstream 
side exceeds that on the upstream side 
(i.e., reverse flow is not allowed) 

 

Pressure Breaker 
Valve (PBV) 

PBVs force a specified pressure loss to occur 
across the valve. Flow through the valve can 
ōŜ ƛƴ ŜƛǘƘŜǊ ŘƛǊŜŎǘƛƻƴΦ t.±Ωǎ ŀǊŜ ƴƻǘ ǘǊǳŜ 
physical devices but can be used to model 
situations where a particular pressure drop is 
known to exist. 
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Valve type Description Image 

Flow Control Valve 
(FCV) 

FCVs limit the flow to a specified amount. The 
program produces a warning message if this 
flow cannot be maintained without having to 
add additional head at the valve (i.e., the flow 
cannot be maintained even with the valve 
fully open). 

 

 
 

Throttle Control 
Valve (TCV) 

TCVs simulate a partially closed valve by 
adjusting the minor head loss coefficient of 
the valve. A relationship between the degree 
to which a valve is closed and the resulting 
head loss coefficient is usually available from 
the valve manufacturer. 

 

 
 

General Purpose 
Valve (GPV) 

GPVs are used to represent a link where the 
user supplies a special flow - head loss 
relationship instead of following one of the 
standard hydraulic formulas. They can be used 
to model turbines, well draw-down or 
reduced-flow backflow prevention valves. 

 

 
 

 
Each type of valve has a different type of setting parameter that describes its operating point (pressure 
for PRVs, PSVs, and PBVs; flow for FCVs; loss coefficient for TCVs, and head loss curve for GPVs). Valves 
can have their control status overridden by specifying they be either completely open or completely 
closed. ! ǾŀƭǾŜΩǎ ǎǘŀǘǳǎ ŀƴŘ ƛǘǎ ǎŜǘǘƛƴƎ Ŏŀƴ ōŜ ŎƘŀƴƎŜŘ ŘǳǊƛng the simulation by using control 
statements. 
 
Because of the ways in which valves are modelled the following rules apply when adding valves to a 
network: 

¶ A PRV, PSV or FCV cannot be directly connected to a reservoir or tank (use a length of pipe to 
separate the two) 

¶ PRVs cannot share the same downstream node or be linked in series. 

¶ Two PSVs cannot share the same upstream node or be linked in series. 

¶ A PSV cannot be connected to the downstream node of a PRV. 
 
9.2.3 Types of objects 

GISpipe contains both physical objects that can appear on the Map Viewer, and non-physical objects 
that encompass design and operational information. These objects can be classified as followed: 

1. Nodes (Junctions, Reservoirs & Tanks) 
2. Links (Pipes, Pumps, Valves) 
3. Map labels 
4. Time Patterns 
5. Curves 
6. Controls (Simple and/or Rule-Based) 
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9.2.4 Adding objects 

GISpipe allows manual digitization of new components directly on the map. 
 
To Add Network elements: 
Go to the Edit tab (Figure 9-18) 
 

 
Figure 9-18: Edit Tab (adding network elements) 

 
Select the object type: 

 Junction  
 Pipe  
 Reservoir 
 Tank 
 Pump  
 Valve  

Or  
 Label 

 
Adding a Node 
 
Select the type of node (junction, reservoir, or tank) and move the mouse cursor to the desired 
location on the Viewer Map and click to place the object on the specified location (Figure 9-19). 
 

 
Figure 9-19: Added a junction node 

 
Once the object was added it would have been included in the list of objects and its properties can be 
set, as shown in Figure 9-20. 
 
Attributes will be auto-filled with default values (editable via the Property Editor, example shown in 
Figure 9-20). 



 

GISpipe ς User manual 43 

 
Figure 9-20: Object properties 

 
The user has the option to move the object to a different place by either selecting in in the Map Viewer 
ŀƴŘ ŘǊŀƎƎƛƴƎ ƛǘ ǘƻ ŀ ƴŜǿ ƭƻŎŀǘƛƻƴ ƻǊ ǘƘŜ ƻōƧŜŎǘΩǎ ƳŀǇ ŎƻƻǊŘƛƴŀǘŜǎ ό· ŀƴŘ ¸ύ ŎƻǳƭŘ ōŜ ǎŜǘ ƛƴ ǘƘŜ 
Properties Editor. To be able to drag the object to a new position would however require the user to 
first change the cursor selection function by clicking on the  button and changing the cursor to the 
Select option as shown in Figure 9-21. 
 

 
Figure 9-21: Changing cursor function 
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The cursor pointer would change to a cross with a square block when moving over the Map Viewer 
area and change to a cross with a green circle (depending on setting, see Figure 7-12) when hovering 
over the object as shown in Figure 9-22 and Figure 9-23. 
 

 
Figure 9-22: Mouse cursor over Map Viewer Area 

 

 
Figure 9-23: Mouse cursor over object 

 
Adding a Link 
 
Select the type of link (Pipes, Pumps or Valves) (Figure 9-18) and move the mouse cursor to the desired 
location on the Viewer Map.  
 
Click ǘƘŜ ƳƻǳǎŜ ǿƘŜƴ ƻǾŜǊ ǘƘŜ ƭƛƴƪΩǎ ǎǘŀǊǘ ƴƻŘŜΦ  
 
Move mouse to thŜ ƭƛƴƪΩǎ ŜƴŘ ƴƻŘŜ ŀƴŘ click on that object (Figure 9-24). 
 

 
Figure 9-24: Add a pipe link 

 
Tip: Use the Pan and Zoom tools for precise placement (Figure 9-25). Pipes must snap to valid start 
and end nodes. 
 

    
Figure 9-25: Pan and Zoom tools of Map Viewer Area 

 
 
 



 

GISpipe ς User manual 45 

If the link is a pipe and the user requires it to have a curvature or change direction move the mouse in 
ǘƘŜ ŘƛǊŜŎǘƛƻƴ ƻŦ ǘƘŜ ƭƛƴƪΩǎ ŜƴŘ ƴƻŘŜΣ clicking it at those intermediate points where it is necessary to 
ŎƘŀƴƎŜ ǘƘŜ ƭƛƴƪΩǎ ŘƛǊŜŎǘƛƻƴΦ Then click ǘƘŜ ƳƻǳǎŜ ŀ Ŧƛƴŀƭ ǘƛƳŜ ƻǾŜǊ ǘƘŜ ƭƛƴƪΩs end node as shown in 
Figure 9-26. 
 

 
Figure 9-26: Creating a pipe with a curvature 

 
Pressing the right mouse button or the Escape key while drawing a link will cancel the operation. 
 
Use the Edit Vertices     tool, available from the Edit Facilities toolbar (Figure 9-27) to adjust the 
geometry of pipes. As described intermediate points could be added to model curved or offset 
alignments and can be moved after initially drawing these on the map. 
 

 
Figure 9-27: Edit Facilities toolbar 

 
Select the Edit Vertices tool and then select a pipe with vertices. Clicking on an intermediate point will 
change the colour of the selected point to a red dot (Figure 9-28). Click and hold in the left mouse 
button allows the user to drag it to a new position. Release mouse button when in the correct position. 
Right click to accept the change. 
 

 
Figure 9-28: Editing vertices 

 
When hovering over a selected link the cursor would change to a green cross as shown in Figure 9-29. 
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Figure 9-29: Selecting a link 

 
Valves and pumps are added in a similar way (Figure 9-30). These links would require specific 
information as described in Section 9.2.5 as well as Table 9-12 and Table 9-13. 
 

 
Figure 9-30: Links - Pumps and valves 

 
Additional editing functions can be found by selecting a link or node and right clicking the mouse as 
shown in Figure 9-31 with functions described in Table 9-7.  
 

 
Figure 9-31: Additional editing functions 
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Table 9-7: Additional editing functions 

Option Description 

View Selected Shapes Table (1) View all the selected objects in a table format. Value in 
brackets indicates number of objects selected). A mixture 
of objects can be selected simultaneously and the similar 
objects will be grouped together in tables. 

Automatically connect selected 
junction to pipe 

Connects a selected junction (node) to the nearest or 
chosen pipe in the model. This is useful when placing a 
new junction as it automatically snaps and links into the 
network. 

Enable !ŎǘƛǾŀǘŜǎ ƻǊ άǘǳǊƴǎ ƻƴέ ǘƘŜ ǎŜƭŜŎǘŜŘ ŜƭŜƳŜƴǘǎ όǇƛǇŜǎΣ 
pumps, valves, etc.) so that they are included in the 
hydraulic simulation. 

Disable 5ŜŀŎǘƛǾŀǘŜǎ ƻǊ άǘǳǊƴǎ ƻŦŦέ ǘƘŜ ǎŜƭŜŎǘŜŘ ŜƭŜƳŜƴǘǎΦ 5ƛǎŀōƭŜŘ 
objects remain visible in the network but are ignored in 
the simulation (no flow or headloss is calculated through 
them). 

Change Start Node To End Node Changes the links begin and end point. Important for 
pumps and valves.  

Generate Junctions at equal 
intervals along the selected pipe 

Junctions will be added along the selected pipe based on a 
distance entered by the user. 

Select Source Highlights and selects all upstream elements in the 
network that contribute flow to the currently selected 
node, junction, or pipe. Useful for tracing the origin of 
water supply. 

Select Service Area Selects all downstream elements supplied from the 
selected source (junction, reservoir, or tank). This allows 
defining quickly the service area fed by a given node. 

Inverse Selection Reverses the current selection. All unselected objects 
become selected, and all selected objects become 
unselected. 

Selected shape layer operations Allows operations (copy, move, delete, or edit attributes) 
to be performed on the layer of the selected shapes, 
treating them as a group. 

Set Colour Selected Shapes Changes the colour of the selected objects 

Hide Selected Shapes Hides a selected object 

Show Hidden Shapes Shows any hidden objects 

Change Pipe A link can be changed to a Pipe, Pump or Valve.  
A node can be changed to a Junction, Reservoir or Tank. 

 
Adding a Map Label 
 
To add a label to the map, click the Label button on the Edit toolbar (Figure 9-18). 
 
Click the mouse on the map where the label should be placed. 
 
Enter the caption for the label and press the Enter key. 
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Figure 9-32: Adding a label to the map 

 
The properties of the label can be changed in the Properties Editor, if the label was selected (Figure 
9-33). 
 

 
Figure 9-33: Properties of the label 

 
To add a non-visual object (Curve, Time Pattern, Controls) to the network see Section 9.2.6. 
 
9.2.5 Editing Visual Objects 

Each component in GISpipe has editable attributes accessible via the Property Editor example shown 
in Figure 9-34, or the Attribute Table, Figure 9-35. It is used to edit the properties of objects that can 
appear on the Viewer Map (Junctions, Reservoirs, Tanks, Pipes, Pumps, Valves, or Labels). 
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Figure 9-34: Properties editor (example) 

 

 
Figure 9-35: Attribute table (example) 

 
To edit one of these objects, select the object on the Viewer Map or double-click a cell in the Table 
view.  
 
Entered values/changes are saved automatically. 
 
The associated properties of each of these types of objects are described in Table 9-8 to Table 9-14. 
 
Tip: Use the Search/Filter option in the table to isolate and bulk-edit similar elements. 
 
Note: The unit system in which object properties are expressed depends on the choice of units for 
flow rate. Using a flow rate expressed in litres or cubic meters means that SI metric units will be used. 
Using a flow rate expressed in cubic feet, gallons or acre-feet means that US units will be used for all 
quantities. Flow units are selected by clicking the Hydraulics toolbar button (see Figure 9-36) or Unit 
on the Status Bar (see Figure 9-37). The units used for all properties are summarized in Appendix B. 
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Figure 9-36: Hydraulics options 

 

 
Figure 9-37: Flow Unit options 

 
The junction properties are provided in Table 9-8. 
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Table 9-8: Junction properties 

Property Description 

Junction ID A unique label used to identify the junction. It can consist of a 
combination of up to 15 numerals or characters. It cannot be the same as 
the ID for any other node. This is a required property. 

X-Coordinate The horizontal location of the junction on the map, measured in the 
ƳŀǇΩǎ ŘƛǎǘŀƴŎŜ ǳƴƛǘǎΦ LŦ ƭŜŦǘ ōƭŀƴƪ ǘƘŜ ƧǳƴŎǘƛƻƴ ǿƛƭƭ ƴƻǘ ŀǇǇŜŀǊ ƻƴ ǘƘŜ 
network map. 

Y-Coordinate ¢ƘŜ ǾŜǊǘƛŎŀƭ ƭƻŎŀǘƛƻƴ ƻŦ ǘƘŜ ƧǳƴŎǘƛƻƴ ƻƴ ǘƘŜ ƳŀǇΣ ƳŜŀǎǳǊŜŘ ƛƴ ǘƘŜ ƳŀǇΩǎ 
distance units. If left blank the junction will not appear on the network 
map. 

Description An optional text string that describes other significant information about 
the junction. 

Tag An optional text string (with no spaces) used to assign the junction to a 
category, such as a pressure zone. 

Elevation The elevation in meters (feet) above some common reference of the 
junction. This is a required property. Elevation is used only to compute 
pressure at the junction. It does not affect any other computed quantity. 

Base Demand The average or nominal demand for water by the main category of 
consumer at the junction, as measured in the current flow units. A 
negative value is used to indicate an external source of flow into the 
junction. If left blank then demand is assumed to be zero. 

Demand Pattern The ID label of the time pattern used to characterize time variation in 
demand for the main category of consumer at the junction. The pattern 
provides multipliers that are applied to the Base Demand to determine 
actual demand in a given time period. If left blank then the Default Time 
Pattern assigned in the Hydraulic Options (see Section 9.4.1) will be used. 

Demand Categories Number of different categories of water users defined for the junction. 
Click the ellipsis button (or hit the Enter key) to bring up a special 
Demands Editor which will let the user assign base demands and time 
patterns to multiple categories of users at the junction. Ignore if only a 
single demand category will suffice. 

Emitter Coefficient Discharge coefficient for emitter (sprinkler or nozzle) placed at junction. 
The coefficient represents the flow (in current flow units) that occurs at 
a pressure drop of 1 psi (or meter). Leave blank if no emitter is present. 
See the Emitters topic in Section 9.2.2 for more details. 

Initial Quality Water quality level at the junction at the start of the simulation period. 
Can be left blank if no water quality analysis is being made or if the level 
is zero. 

Source Quality Quality of any water entering the network at this location. Click the 
ellipsis button (or hit the Enter key) to bring up the Source Quality Editor 
(see Section 9.2.6 below). 

 
 

The reservoir properties are provided in Table 9-9.  
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Table 9-9: Reservoir properties 

Property Description 

Reservoir ID A unique label used to identify the reservoir. It can consist of a 
combination of up to 15 numerals or characters. It cannot be the same 
as the ID for any other node. This is a required property. 

X-Coordinate The horizontal location of the reservoir on the map, measured in 
the ƳŀǇΩǎ distance units. If left blank the reservoir will not appear on 
the network map. 

Y-Coordinate The vertical location of the reservoir on the map, measured in the 
ƳŀǇΩǎ ŘƛǎǘŀƴŎŜ ǳƴƛǘǎΦ LŦ ƭŜŦǘ ōƭŀƴƪ ǘƘŜ ǊŜǎŜǊǾƻƛǊ ǿƛƭƭ ƴƻǘ ŀǇǇŜŀǊ ƻƴ ǘƘŜ 
network map. 

Description An optional text string that describes other significant information 
about the reservoir. 

Tag An optional text string (with no spaces) used to assign the reservoir to 
a category, such as a pressure zone 

Total Head The hydraulic head (elevation + pressure head) of water in the 
reservoir in feet (meters). This is a required property. 

Head Pattern The ID label of a time pattern used to model time variation in the 
ǊŜǎŜǊǾƻƛǊΩǎ head. Leave blank if none applies. This property is useful if 
the reservoir represents a tie-in to another system whose pressure 
varies with time. 

Initial Quality Water quality level at the reservoir. Can be left blank if no water quality 
analysis is being made or if the level is zero. 

Source Quality Quality of any water entering the network at this location. Click the 
ellipsis button (or hit the Enter key) to bring up the Source Quality 
Editor (Figure 9-40). 

 
The tank properties are provided in Table 9-10. 
 
 

Table 9-10: Tank properties 

Property Description 

Tank ID A unique label used to identify the tank. It can consist of a 
combination of up to 15 numerals or characters. It cannot be the same 
as the ID for any other node. This is a required property. 

X-Coordinate ¢ƘŜ ƘƻǊƛȊƻƴǘŀƭ ƭƻŎŀǘƛƻƴ ƻŦ ǘƘŜ ǘŀƴƪ ƻƴ ǘƘŜ ƳŀǇΣ ƳŜŀǎǳǊŜŘ ƛƴ ǘƘŜ ƳŀǇΩǎ 
scaling units. If left blank the tank will not appear on the network map. 

Y-Coordinate The vertical location of the tank on the map, measured in the ƳŀǇΩǎ 
scaling units. If left blank the tank will not appear on the network map. 

Description Optional text string that describes other significant information about 
the tank. 

Tag Optional text string (with no spaces) used to assign the tank to a 
category, such as a pressure zone 

Elevation Elevation above a common datum in feet (meters) of the bottom shell 
of the tank. This is a required property. 

Initial Level Height in feet (meters) of the water surface above the bottom 
elevation of the tank at the start of the simulation. This is a required 
property. 

Minimum Level Minimum height in feet (meters) of the water surface above the 
bottom elevation that will be maintained. The tank will not be allowed 
to drop below this level. This is a required property. 
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Property Description 

Maximum Level Maximum height in feet (meters) of the water surface above the 
bottom elevation that will be maintained. The tank will not be allowed 
to rise above this level. This is a required property. 

Diameter The diameter of the tank in feet (meters). For cylindrical tanks this is 
the actual diameter. For square or rectangular tanks, it can be an 
equivalent diameter equal to 1.128 times the square root of the cross-
sectional area. For tanks whose geometry will be described by a curve 
(see below) it can be set to any value. This is a required property. 

Minimum Volume The volume of water in the tank when it is at its minimum level, in cubic 
feet (cubic meters). This is an optional property, useful mainly for 
describing the bottom geometry of non-cylindrical tanks where a full 
volume versus depth curve will not be supplied (see below). 

Volume Curve The ID label of a curve used to describe the relation between tank 
volume and water level. If no value is supplied then the tank is assumed 
to be cylindrical. 

Mixing Model The type of water quality mixing that occurs within the tank. The 
choices include 
- MIXED (fully mixed) 
- 2COMP (two-compartment mixing) 
- FIFO (first-in first-out plug flow) 
- LIFO (last-in first-out plug flow) 
See the Mixing Models Topic in Section 9.1.2 for more information. 

Mixing Fraction ¢ƘŜ ŦǊŀŎǘƛƻƴ ƻŦ ǘƘŜ ǘŀƴƪΩǎ ǘƻǘŀƭ ǾƻƭǳƳŜ ǘƘŀǘ ŎƻƳǇǊƛǎŜǎ ǘƘŜ ƛƴƭŜǘ-outlet 
compartment of the two-compartment (2COMP) mixing model. Can 
be left blank if another type of mixing model is employed. 

Reaction 
Coefficient 

The bulk reaction coefficient for chemical reactions in the tank. Time 
units are 1/days. Use a positive value for growth reactions and a 
negative value for decay. Leave blank if the Global Bulk reaction 
coefficient specified in ǘƘŜ ǇǊƻƧŜŎǘΩǎ Reactions Options will apply. See 
Water Quality Reactions in Table 9-24 for more information. 

Initial Quality Water quality level in the tank at the start of the simulation. Can be 
left blank if no water quality analysis is being made or if the level is 
zero. 

Source Quality Quality of any water entering the network at this location. Click the 
ellipsis button (or hit the Enter key) to bring up the Source Quality Editor 
(see Figure 9-40). 

 
The pipe properties are provided in Table 9-11. 
 
 

Table 9-11: Pipe properties 

Property Description 

Pipe ID A unique label used to identify the pipe. It can consist of a combination 
of up to 15 numerals or characters. It cannot be the same as the ID for 
any other link. This is a required property. 

Start Node The ID of the node where the pipe begins. This is a required property. 

End Node The ID of the node where the pipe ends. This is a required property. 

Description An optional text string that describes other significant information 
about the pipe. 

Tag An optional text string (with no spaces) used to assign the pipe to a 
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Property Description 

category, perhaps one based on age or material. 

Length The actual length of the pipe in feet (meters). This is a required 
property. 

Diameter The pipe diameter in inches (mm). This is a required property. 

Roughness The roughness coefficient of the pipe. It is unitless for Hazen-
Williams or Chezy-Manning roughness and has units of millifeet (mm) 
for Darcy-Weisbach roughness. This is a required property. 

Loss Coefficient Unitless minor loss coefficient associated with bends, fittings, etc. 
Assumed 0 if left blank. 

Initial Status Determines whether the pipe is initially open, closed, or contains a 
check valve. If a check valve is specified then the flow direction in the 
pipe will always be from the Start node to the End node. 

Bulk Coefficient The bulk reaction coefficient for the pipe. Time units are 1/days. Use a 
positive value for growth and a negative value for decay. Leave blank if 
the Global Bulk reaction coefficient from the ǇǊƻƧŜŎǘΩǎ Reaction Options 
will apply. See Water Quality Reactions in Table 9-24 for more 
information. 

Wall Coefficient The wall reaction coefficient for the pipe. Time units are 1/days. Use a 
positive value for growth and a negative value for decay. Leave blank if 
the Global Wall reaction coefficient from the ǇǊƻƧŜŎǘΩǎ Reactions 
Options will apply. See Water Quality Reactions in Table 9-24 for more 
information. 

 
Note:  
Pipe lengths can be automatically computed as pipes are added or repositioned on the Viewer Map. 
If the Auto-Length setting is turned on. Toggle this setting On/Off, by clicking the Options toolbar 
button and Checking/Unchecking the Auto-length (see Figure 7-12). Be sure to provide meaningful 
dimensions for the Viewer Map before using the Auto-Length feature. 
 
The pump properties are provided in Table 9-12. 
 
 

Table 9-12: Pump properties 

Property Description 

Pump ID A unique label used to identify the pump. It can consist of a 
combination of up to 15 numerals or characters. It cannot be the same 
as the ID for any other link. This is a required property. 

Start Node The ID of the node on the suction side of the pump. This is a required 
property. 

End Node The ID of the node on the discharge side of the pump. This is a 
required property. 

Description An optional text string that describes other significant information 
about the pump. 

Tag An optional text string (with no spaces) used to assign the pump to a 
category, perhaps based on age, size or location. 

Pump Curve The ID label of the pump curve used to describe the relationship 
between the head delivered by the pump and the flow through the 
pump. Leave blank if the pump will be a constant energy pump (see 
below). 
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Property Description 

Power The power supplied by the pump in horsepower (kw). Assumes that 
the pump supplies the same amount of energy no matter what the flow 
is. Leave blank if a pump curve will be used instead. Use when pump 
curve information is not available. 

Speed The relative speed setting of the pump (unitless). For example, a speed 
setting of 1.2 implies that the rotational speed of the pump is 20% 
higher than the normal setting. 

Pattern ¢ƘŜ L5 ƭŀōŜƭ ƻŦ ŀ ǘƛƳŜ ǇŀǘǘŜǊƴ ǳǎŜŘ ǘƻ ŎƻƴǘǊƻƭ ǘƘŜ ǇǳƳǇΩǎ ƻǇŜǊŀǘƛƻƴΦ 
The multipliers of the pattern are equivalent to speed settings. A 
multiplier of zero implies that the pump will be shut off during the 
corresponding time period. Leave blank if not applicable. 

Initial Status State of the pump (open or closed) at the start of the simulation period. 

Efficiency Curve ¢ƘŜ L5 ƭŀōŜƭ ƻŦ ǘƘŜ ŎǳǊǾŜ ǘƘŀǘ ǊŜǇǊŜǎŜƴǘǎ ǘƘŜ ǇǳƳǇΩǎ wire-to-water 
efficiency (in percent) as a function of flow rate. This information is used 
only to compute energy usage. Leave blank if not applicable or if the 
Ǝƭƻōŀƭ ǇǳƳǇ ŜŦŦƛŎƛŜƴŎȅ ǎǳǇǇƭƛŜŘ ǿƛǘƘ ǘƘŜ ǇǊƻƧŜŎǘΩǎ 9ƴŜǊƎȅ hǇǘƛƻƴǎ όǎŜŜ 
Table 9-25) will be used. 

Energy Price The average or nominal price of energy in monetary units per kW-hr. 
Used only for computing the cost of energy usage. Leave blank if not 
applicable or if ǘƘŜ Ǝƭƻōŀƭ ǾŀƭǳŜ ǎǳǇǇƭƛŜŘ ǿƛǘƘ ǘƘŜ ǇǊƻƧŜŎǘΩǎ 9ƴŜǊƎȅ 
Options (Table 9-25) will be used. 

Price Pattern The ID label of the time pattern used to describe the variation in energy 
price throughout the day. Each multiplier in the pattern is applied to 
ǘƘŜ ǇǳƳǇΩǎ 9ƴŜǊƎȅ Price to determine a time-of-day pricing for the 
corresponding period. Leave blank if not applicable or if the global 
ǇǊƛŎƛƴƎ ǇŀǘǘŜǊƴ ǎǇŜŎƛŦƛŜŘ ƛƴ ǘƘŜ ǇǊƻƧŜŎǘΩǎ 9ƴŜǊƎȅ hǇǘƛƻƴǎ όTable 9-25) 
will be used. 

 
The valve properties are provided in Table 9-13. 
 
 

Table 9-13: Valve properties 

Property Description 

ID Label A unique label used to identify the valve. It can consist of a combination 
of up to 15 numerals or characters. It cannot be the same as the ID for 
any other link. This is a required property. 

Start Node The ID of the node on the nominal upstream or inflow side of the valve. 
(PRVs and PSVs maintain flow in only a single direction.) This is a 
required property. 

End Node The ID of the node on the nominal downstream or discharge side of 
the valve. This is a required property. 

Description An optional text string that describes other significant information 
about the valve. 

Tag An optional text string (with no spaces) used to assign the valve to a 
category, perhaps based on type or location. 

Diameter The valve diameter in inches (mm). This is a required property. 

Type The valve type (PRV, PSV, PBV, FCV, TCV, or GPV). See Table 9-6 for 
descriptions of the various types of valves. This is a required property. 
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Property Description 

Setting A required parameter for each valve type that describes its operational 
setting: 
PRV - Pressure (psi or m) 
PSV - Pressure (psi or m) 
PBV - Pressure (psi or m) 
FCV - Flow (flow units) 
TCV - Loss Coeff (unitless) 
GPV - ID of head loss curve 

Loss Coefficient Unitless minor loss coefficient that applies when the valve is 
completely opened. Assumed 0 if left blank. 

Fixed Status Valve status at the start of the simulation. If set to OPEN or CLOSED 
then the control setting of the valve is ignored and the valve behaves 
as an open or closed link, respectively. If set to NONE, then the valve 
will behave as intended. A ǾŀƭǾŜΩǎ fixed status and its setting can be 
made to vary throughout a simulation by the use of control statements. 
LŦ ŀ ǾŀƭǾŜΩǎ ǎǘŀǘǳǎ ǿŀǎ ŦƛȄŜŘ ǘƻ ht9bκ/[h{95Σ then it can be made 
active again using a control that assigns a new numerical setting to it. 

 
The label properties are provided in Table 9-14. 
 
Table 9-14: Label properties 

Property Description 

Caption ¢ƘŜ ƭŀōŜƭΩǎ ǘŜȄǘΦ 

X-Coordinate The horizontal location of the upper left corner of the label on the map, 
ƳŜŀǎǳǊŜŘ ƛƴ ǘƘŜ ƳŀǇΩǎ ǎŎŀƭƛƴƎ ǳƴƛǘǎΦ ¢Ƙƛǎ ƛǎ ŀ ǊŜǉǳƛǊŜŘ ǇǊƻǇŜǊǘȅΦ 

Y-Coordinate The vertical location of the upper left corner of the label on the map, 
measured ƛƴ ǘƘŜ ƳŀǇΩǎ ǎŎŀƭƛƴƎ ǳƴƛǘǎΦ ¢Ƙƛǎ ƛǎ ŀ ǊŜǉǳƛǊŜŘ ǇǊƻǇŜǊǘȅΦ 

Font Launches ŀ Cƻƴǘ ŘƛŀƭƻƎ ǘƘŀǘ ŀƭƭƻǿǎ ǎŜƭŜŎǘƛƻƴ ƻŦ ǘƘŜ ƭŀōŜƭΩǎ ŦƻƴǘΣ ǎƛȊŜΣ 
and style. 

 
9.2.6 Editing Non-Visual Objects 

Curves, Time Patterns, Controls and Calibration have special editors that are used to define their 
properties. To edit one of these objects, from the Settings Toolbar click on the object (see Figure 9-38) 
to edit.  
 

 
Figure 9-38: Non-visual objects settings 

 
In addition, the Property Editor for Junctions contains an ellipsis button in the field for Demand 
Categories that brings up a special Demand Editor when clicked (Figure 9-39). 
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Figure 9-39: Demand Categories Editor 

 
Similarly, the Source Quality field in the Property Editor for Junctions, Reservoirs, and Tanks has a 
button that launches a special Source Quality Editor (Figure 9-40). Each of these specialized editors is 
described next. 
 

 
Figure 9-40: Source Quality Editor 

 
Curves Editor 
 
The Curves Editor is a dialog form as shown in Figure 9-41. To use the Curve Editor, enter values for 
the items as listed in Table 9-15. The Curve Editor can be used to enter a Volume, Pump, Efficiency or 
Headloss curve by simply selecting the tab at the top of the dialog form.  
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Figure 9-41: Curves Editor 

 
A Volume Curve determines how storage tank volume (Y) varies as a function of water level (X). It is 
used when it is necessary to accurately represent tanks whose cross-sectional area varies with height. 
The lower and upper water levels supplied for the curve must contain the lower and upper levels 
between which the tank operates.  
 
A Pump Curve represents the relationship between the head and flow rate that a pump can deliver at 
its nominal speed setting. Head is the head gain imparted to the water by the pump and is plotted on 
the vertical (Y) axis of the curve in head units. Flow rate is plotted on the horizontal (X) axis in flow 
units. A valid pump curve must have decreasing head with increasing flow. 
 
An Efficiency Curve, only used for energy calculations, determines pump efficiency (Y in percent) as a 
function of pump flow rate (X in flow units). Efficiency should represent wire-to-water efficiency that 
takes into account mechanical losses in the pump itself and the electrical losses in ǘƘŜ ǇǳƳǇΩǎ ƳƻǘƻǊΦ 
If not supplied for a specific pump, then a fixed global pump efficiency will be used. 
A Headloss Curve is used to described the headloss (Y) through a General-Purpose Valve (GPV) as a 
function of flow rate (X). It provides the capability to model devices and situations with unique 
headloss-flow relationships, such as reduced flow - backflow prevention valves, turbines, and well 
draw-down behaviour. 
 
Select the curve that needs to be entered (by selecting the tab at the top of the dialogue form) and 
click on the Add button to generate a blank curve that can be populated. Similarly, a specific curve can 
be selected (checking the box next to the curve) and click on the Delete button. Selecting a curve or 
multiple curves (checking the box) and clicking on the Chart button will plot the selected curve(s) as 
depicted in Figure 9-42, an example of a pump curve.  Click on the Save button to save the entered 
curves and click on the Close button to close the Edit Curve Editor. 
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Table 9-15: Curves Editor 

Item Description 

Volume 

Curve name A unique name that can be used to refer to this specific curve 

Description Optional description of what the curve represents 

Height The height (units is linked to the selected flow units) 

Volume The volume (units is linked to the selected flow units) 

Pump 

Curve name ID label of the curve (maximum of 15 numerals or characters) 

Description Optional description of what the curve represents 

Curve Type Type of curve 

Head The pumping head, corresponding to a specific flow, i.e., X-Y point on the 
curve (units is linked to the selected flow units) 

Flow The flow, corresponding to a specific pumping head, i.e., X-Y point on the 
curve (units is linked to the selected flow units) 

Efficiency 

Curve name A unique name that can be used to refer to this specific curve 

Description Optional description of what the curve represents 

Flow The flow rate, corresponding to a specific efficiency (units is linked to the 
selected flow units) 

Efficiency The efficiency, corresponding to a specific flow rate (units is linked to the 
selected flow units) 

Headloss 

Curve name A unique name that can be used to refer to this specific curve 

Description Optional description of what the curve represents 

Flow The flow rate, corresponding to a specific headloss (units is linked to the 
selected flow units) 

Headloss The headloss, corresponding to a specific flow rate (units is linked to the 
selected flow units) 

 

 
Figure 9-42: Chart of pump curve 
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Pattern Editor 
 
A Time Pattern is a collection of multipliers that can be applied to a quantity to allow it to vary over 
time. Nodal demands, reservoir heads, pump schedules, and water quality source inputs can all have 
time patterns associated with them. The time interval used in all patterns is a fixed value, set with the 
ǇǊƻƧŜŎǘΩǎ ¢ƛƳŜ hǇǘƛƻƴǎΦ ²ƛǘƘƛƴ ǘƘƛǎ ƛƴǘŜǊǾŀƭ ŀ ǉǳŀƴǘƛǘȅ ǊŜƳŀƛƴǎ ŀǘ ŀ Ŏƻƴǎǘŀƴǘ ƭŜǾŜƭΣ Ŝǉǳŀƭ ǘƻ ǘƘŜ ǇǊƻŘǳŎǘ 
of its nominal value and ǘƘŜ ǇŀǘǘŜǊƴΩǎ ƳǳƭǘƛǇƭƛŜǊ ŦƻǊ ǘƘŀǘ ǘƛƳŜ ǇŜǊƛƻŘΦ !ƭǘƘƻǳƎƘ ŀƭƭ ǘƛƳŜ ǇŀǘǘŜǊƴǎ Ƴǳǎǘ 
utilize the same time interval, each can have a different number of periods. When the simulation clock 
exceeds the number of periods in a pattern, the pattern wraps around to its first period again. 
 
The Pattern Editor, displayed in Figure 9-43, edits the properties of a time pattern object. To use the 
Pattern Editor, enter values for the items as listed in Table 9-16. A small chart is drawn above the 
column for each entered pattern, see Figure 9-43. 
 

 
Figure 9-43: Pattern Editor 
 

 
Table 9-16: Pattern Editor 

Item Description 

Pattern Name Unique name of the time pattern. 

Description Optional description of what the pattern represents. 

Multipliers Multiplier value for each time period of the pattern. 

 
Click on the Set Time button (Figure 9-43) to set the Duration, Start Time and Time Step as shown in 
Figure 9-44. Click on the Add button to generate a blank pattern (column) that can be populated. 
Similarly, a specific pattern can be selected (checking the box next to the Pattern Name) and click on 
the Delete button. 
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Figure 9-44: Set time dialogue form 

 
Selecting a pattern or multiple patterns (checking the box next to the Pattern Name) and clicking on 
the Chart button will plot the selected pattern(s) as depicted in Figure 9-45, an example of a pump 
curve.  Click on the Save button to save the entered curves and click on the Close button to close the 
Time Pattern Editor. 
 

 
Figure 9-45: Time pattern chart 

 
Right click anywhere on the Chart (Figure 9-45) will show the various options to modify the General 
look (colours, views and title), Horizontal Axis (minimum, maximum, increments, grid lines & title), 
Vertical Axis (minimum, maximum, increments, grid lines & title), Legend (position, colour, size, 
framed & visibility) and Series (series, title, symbology of lines, markers and labels) as depicted in 
Figure 9-46.  
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Figure 9-46: Graph options 

 
Click the Save button to ǎŀǾŜ ǘƘŜ ŎǳǊǊŜƴǘ ǇŀǘǘŜǊƴΩǎ Řŀǘŀ ǘƻ ŀ ŦƛƭŜΦ 
 
Controls Editor 
 
The Controls Editor, shown in Figure 9-47, is a text editor window used to edit both simple and rule-
based controls. 
 

 
Figure 9-47: Control Editor 
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Controls are statements that determine how the network is operated over time. They specify the 
status of selected links as a function of time, tank water levels, and pressures at select points within 
the network. There are two categories of controls that can be used: 

¶ Simple Controls 

¶ Rule-Based Controls Simple Controls 
 
Simple Controls 
Simple controls change the status or setting of a link based on: 
ω ¢ƘŜ ǿŀǘŜǊ ƭŜǾŜƭ ƛƴ ŀ ǘŀƴƪ 
ω ¢ƘŜ ǇǊŜǎǎǳǊŜ ŀǘ ŀ ƧǳƴŎǘƛƻƴ 
ω ¢ƘŜ ǘƛƳŜ ƛƴǘƻ ǘƘŜ ǎƛƳǳƭŀǘƛƻƴ 
ω ¢ƘŜ ǘƛƳŜ ƻŦ Řŀȅ 
They are statements expressed in one of the following three formats: 
 

LINK x status IF NODE y ABOVE/BELOW z 

LINK x status AT TIME t   

LINK x status AT CLOCKTIME c AM/PM  

where:   
x = a link ID label 
status = OPEN or CLOSED, a pump speed setting, or a control valve setting 
y = a node ID label 
z = a pressure for a junction or a water level for a tank 
t = a time since the start of the simulation (decimal hours or hours:minutes) 
c = a 24-hour clock time 

 
There is no limit on the number of simple control statements that can be used. 
Note: Level controls are stated in terms of the height of water above the tank bottom, not the 
elevation (total head) of the water surface. 
 
Note: Using a pair of pressure controls to open and close a link can cause the system to become 
unstable if the pressure settings are too close to one another. In this case using a pair of Rule-Based 
controls might provide more stability. 
 
Rule-Based Controls 
Rule-Based Controls allow link status and settings to be based on a combination of conditions that 
might exist in the network after an initial hydraulic state of the system is computed. Here is an example 
of a Rule-Based Control. This set of rules shuts down a pump and opens a by-pass pipe when the level 
in a tank exceeds a certain value and does the opposite when the level is below another value. 
RULE 1 

IF TANK 2 LEVEL ABOVE 6.0 
THEN PUMP 10 STATUS IS CLOSED 
AND PIPE 55 STATUS IS OPEN 

RULE 2 
IF TANK 2 LEVEL BELOW 3.9 
THEN PUMP 10 STATUS IS OPEN 
AND PIPE 55 STATUS IS CLOSED 
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Source Quality Editor 
 
The Source Quality Editor is a pop-up dialog used to describe the quality of source flow entering the 
network at a specific node. This source might represent the main treatment works, a well head or 
satellite treatment facility, or an unwanted contaminant intrusion. The dialog form, shown in Figure 
9-48, contains the following fields (Table 9-17). 
 

 
Figure 9-48: Source Editor 
 
Table 9-17: Source quality parameters 

Field Description 

Source Quality Baseline or average concentration (or mass flow rate per minute) of 
source ς leave blank to remove the source. 

Quality Pattern ID label of time pattern used to make source quality vary with time, 
leave blank if not applicable. 

Source Type Select either: 
- Concentration 
- Mass Booster 
- Setpoint Booster 
- Flow Paced Booster 

 
A water quality source can be designated as a concentration or booster source. 

¶ A concentration source fixes the concentration of any external inflow entering the network, 
such as flow from a reservoir or from a negative demand placed at a junction. 

¶ A mass booster source adds a fixed mass flow to that entering the node from other points in 
the network. 

¶ A flow paced booster source adds a fixed concentration to that resulting from the mixing of 
all inflow to the node from other points in the network. 

¶ A setpoint booster source fixes the concentration of any flow leaving the node (as long as the 
concentration resulting from all inflow to the node is below the setpoint). 

 
The concentration-type source is best used for nodes that represent source water supplies or 
treatment works (e.g., reservoirs or nodes assigned a negative demand). The booster-type source is 
best used to model direct injection of a tracer or additional disinfectant into the network or to model 
a contaminant intrusion. 
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9.2.7 Other modelling parameters 

 
GISpipe provides additional useful functionalities such as assigning a meter to a junction, tracing meter 
location and viewing/editing of the demand table. These functionalities can be accessed from the 
Water Distribution Network Model Toolbar as depicted in Figure 9-49. 
 

 
Figure 9-49: Water Distribution Network Model 

 
Assign meter to junction  
 
This dialog box, Figure 9-50, is for assigning water meter points (from the GIS water meter layer) to 
junctions in the water distribution model. This step links customer demand (from meters) to the 
hydraulic model, see Table 9-18. 
 

 
Figure 9-50: Assign meter to a junction 

 
Table 9-18: Assign meters to junctions 

Item Description 

Assign type 

Allocating meters to 
the entire pipe 
network 

All meters in the meter layer are assigned automatically to the nearest 
junctions in the full network. Use this when you want a complete allocation 
across the model. 

Allocate meters to 
selected pipe 
networks 

Only the meters within the user-selected pipe network(s) are allocated to 
the corresponding junctions. Use this when working on a sub-network or 
when testing a smaller area. 

Additional options 

Assign only selected 
meters 
 

Instead of allocating all meters in the layer, only the currently selected 
subset of meters will be assigned to junctions. This is useful when manually 
controlling which meters are linked. 

Assigned to Junction 
in Water Pipe along 
Supply Pipe 

Ensures that meters are linked to a junction that lies directly along the 
supplying pipe (rather than just the nearest junction by distance). This is a 
more hydraulically correct allocation when working with complex networks. 
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Trace meter location 
 
The Trace meter location dialog window is shown Figure 9-51. This function allows the user to see 
which meters and demands are connected to which junction and allows the user to drag and drop the 
meter to the desired junction which changes the assignment to the new junction, see Figure 9-52. 
 

 
Figure 9-51: Trace meter location dialog window 

 

 
Figure 9-52: Dragging and dropping the meter onto new junction 
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Demand Editor 
 
The Demand Editor is shown in Figure 9-53. It is used to assign base demands and time patterns when 
there is more than one category of water user at a junction. The editor is invoked from the Property 
Editor by clicking the ellipsis button (or hitting the Enter key) when the Demand Categories field has 
the focus.  
 

 
Figure 9-53: Demand Table Editor 

 
The editor is a table containing five columns. Each category of demand is entered as a new row in the 

table. Rows are added or deleted by clicking on the or  buttons. The columns contain the 
following information: 

¶ Demand: baseline or average demand for the category (required) 

¶ Demand Pattern: Pattern name (can be s3eletced from drop down list, as show in Figure 9-53). 
This is used to allow demand to vary with time (optional). 

¶ Categories: text label used to identify the demand category (optional) 

¶ Customer ID: Used to define the category/user.  

¶ Ratio: The ratio of the demand of each customer of the total demand at the specific junction. 
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Note: By convention, the demand placed in the first row of the editor will be considered the main 
category for the junction and will appear in the Base Demand field of the Property Editor. 
 
A summary of all the Demands and Categories, Demand patterns linked to every junction is shown by 
clicking on the Demand Table toolbar button (Figure 9-38). This will provide an overview of all the 
demands, patterns, categories, emitter flows, emitter coefficients, District Metered Areas (DMA) as 
depicted in Figure 9-54. 
 
This Demand Table provides advanced functionality allowing demand values to be imported from 
Microsoft Excel (Figure 9-55), click on the Demand Input in Excel button, change the viewed values  by 
clicking on the Category Distribution button and setting the preference (Figure 9-56) to filter the table. 
 

 
Figure 9-54: Demand Table 

 

 
Figure 9-55: Excel Batch Input 
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Figure 9-56: Category Distribution 

 

9.3 Editing Tools 

9.3.1 Map Tools and Navigation 

 
Undo and Redo 
 
This is one of the most useful functions in GISpipe to assist the user to edit the network. Simply click 
on the buttons above the menu bar to undo or redo the last step. 

Undo  

Redo  
 
Options 
 
GISpipe allows the setting of some of the general preferences 
of the program by clicking on the Options button on the 
Toolbar, which will display Figure 9-57 with descriptions of 
the meaning of theses settings  provided in Table 9-19.  

 
Table 9-19: Description of Option settings 

Option Description 

Use snap feature 
When drawing a pipe, snap may help the cursor lock to an existing node or 
pipe, ensuring alignment of elements in the network model. It makes 
network building more accurate and efficient. 

Show delete 
objects dialog 

When enabled, the software will display a pop-up dialog asking the user to 
confirm before deleting selected objects. This dialog indicates the objects to 
be deleted and offer the options "Yes" and "No". When disabled, objects are 
deleted immediately without confirmation, which may speed up workflows 
but increases the risk of accidental loss. 

Node elevation 
closest to node 
elevation 

Automatically assigns a node's elevation based on the elevation of the 
nearest existing node. Useful when importing or creating nodes without 
specified elevations. It automatically fills in missing elevation data and thus 
maintains topographic continuity in a model when elevation data is 
incomplete. 

Auto length 

If the Auto length setting is turned (Check box is ticked) then drawing a pipe 
link will automatically determine the length of that pipe based on the scale 
of the map. Be sure to provide meaningful dimensions for the Viewer Map 
before using the Auto-Length feature. 
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Option Description 

Scroll Mode 

The user has 3 options: 
- Classic:  Uses standard mouse-based scrolling. Scrollbars behave 

traditionally; users click and drag the scrollbar or use the scroll wheel. 
- Touch: Optimized for touch input. Scrolls like a mobile/tablet interface, 

swiping moves the view, often with inertia (momentum). Scrollbars may 
be hidden or overlaid. 

- Hybrid: Combines both Classic and Touch modes. It detects the input 
method (mouse or touch) and adapts accordingly. 

Cursor The Selection Precision, Cursor Size and Selection Colour can be set 

Map Background 
Colour 

One of two options can be selected White or Black by selecting the radio 
button 

 

 
Figure 9-57: Options 
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Table 9-20: Object's statuses on the map 

A tank which shows 
its status (50% full) 

 

 A tank which shows 
its status (100% full) 

 
A pipe which is 
closed on the map 
screen 

 
 

 A pipe which also 
functions as a check 
valve 

 
A pipe which is open 
on the map screen 

 
 

 A pipe with flow 
arrow indicating the 
direction of flow. 

 
A valve which is in 
the open position. A 
control or its function 
could change this 
status during  an 
extended period 
analysis. 

 

 A valve which is in 
the closed position. A 
control or its function 
could change this 
status during  an 
extended period 
analysis. 

 

A pump which is in 
the open position. A 
control or its function 
could change this 
status during  an 
extended period 
analysis. 

 

 A pump which is in 
the closed position. A 
control or its function 
could change this 
status during  an 
extended period 
analysis. 

 

 
Junction removal 
 
Select the junction J2 as shown in Figure 9-58 and drag it towards junction J3 (by holding in left-mouse 
button). When releasing the mouse button once on the point, junction J2 would be deleted, pipe P2 
will be deleted and Junction J1 will now be directly joined to junction J3 with pipe P1. 
 

 
Figure 9-58: Removing a junction 
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Junction merging 
 
Select junction J3 and drag it towards junction J5 (by holding in left-mouse button), see Figure 9-59. 
When releasing the mouse button once on the point, junction J3 would be deleted and pipe P2 will 
now be connected to junction J5. 
 

 
Figure 9-59: Merging junctions 

 
Clipboard function 
 
The Copy, Cut, Paste functionalities can be selected form the Clipboard toolbar, Figure 9-60. 
 

 
Figure 9-60: Clipboard functions 

 
Alternatively selecting any object or group of objects and pressing Ctrl + C on the keyboard copies 
these objects to the clipboard. 
 
Pressing Ctrl  + V pastes these objects. 
 
These functions can be used between different layers and the objects will be copied onto the actively 
selected layer. 
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9.4 Water Distribution Network Model Settings 

The Water Distribution Network Model Settings provide the foundational parameters required to 
simulate the hydraulic and water quality behaviour of a water supply system. These settings govern 
aspects such as simulation time steps, flow routing, pressure constraints, and quality analysis options, 
ensuring that the model accurately reflects real-world conditions and operates efficiently under 
various scenarios. Proper configuration of these settings is essential for reliable results and meaningful 
analysis. These Settings can be accessed from the Water Distribution Network Model toolbar, see 
Figure 9-61. 
 

 
Figure 9-61: WDNM Settings 

 
The hydraulic, water quality, energy and time settings can be set to analyse the numerical model in a 
specific manner and are described in the following sections. 
 
9.4.1 Hydraulic Options 

The Hydraulic options windows, Figure 9-62, can be accessed by clicking on the Hydraulics button on 
the Water Distribution Network Model Toolbar. 
 

 
Figure 9-62: Hydraulic options 
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Table 9-21: Hydraulic options for hydraulic analysis 

Option Description 

Demand Model Selects between demand or pressure driven analysis ς DDA or PDA, 
respectively. 
DDA assumes demands are fixed at a given point in time, while PDA 
assumes demands are a function of pressure.  
The PDA option can be used to find a solution when negative pressures are 
present in a DDA. 

Flow Units Units in which nodal demands and link flow rates are expressed. Choosing 
units in gallons, cubic feet, or acre-feet implies that the units for all other 
network quantities are Customary US. Selecting litres or cubic meters 
causes all other units to be SI metric. Use caution when changing flow 
units as it might affect all other data supplied to the project. (See 
Appendix B, Units of Measurement) 

Headloss Model Formula used to compute headloss as a function of flow rate in a pipe. 
Choices are: 
- Hazen-Williams 
- Darcy-Weisbach 
- Chezy-Manning 
Because each formula measures pipe roughness differently, switching 
formulas might require that all pipe roughness coefficients be updated. 

Specific Gravity Ratio of the density of the fluid being modelled to that of water at 4 deg. 
C (unitless). 

Relative Viscosity Ratio of the kinematic viscosity of the fluid to that of water at 20 deg. 
C (1.0 centistokes or 0.94 sq ft/day) (unitless). 

Maximum Trials Maximum number of trials used to solve the nonlinear equations that 
govern network hydraulics at a given point in time. Suggested value is 40. 

Relative Accuracy Convergence criterion used to signal that a solution has been found to the 
nonlinear equations that govern network hydraulics. Trials end when the 
sum of all flow changes divided by the sum of all link flows is less than this 
number. Suggested value is 0.001. 

If Unbalanced Action to take if a hydraulic solution is not found within the maximum 
number of trials. Choices are STOP to stop the simulation at this point or 
CONTINUE to use another 10 trials, with no link status changes allowed, in 
an attempt to achieve convergence. 

Default Pattern ID label of a time pattern to be applied to demands at those junctions 
where no time pattern is specified. If no such pattern exists then 
demands will not vary at these locations. 

Demand Multiplier Global multiplier applied to all demands to make total system 
consumption vary up or down by a fixed amount (e.g., 2.0 doubles all 
demands, 0.5 halves them, and 1.0 leaves them as is). 

Emitter Exponent Power to which pressure is raised when computing the flow through an 
emitter device. The textbook value for nozzles and sprinklers is 0.5. This 
may not apply to pipe leakage.  

Status Report Amount of status information to report after an analysis is made. Choices 
are: 
- NO (no reporting) 
- YES (link status changes) 
- FULL (normal plus convergence) 
Full status reporting is only useful for debugging purposes. 

Minimum Pressure In a PDA, the pressure below which demand is assumed to be zero. 
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Option Description 

Required Pressure In a PDA, the pressure required to deliver the full demand. 

Pressure Exponent PDA assumes a pressure demand relation raised to an exponent. Standard 
value is 0.5. 

Max. Head Error Augments the ACCURACY option. Specifies the maximum head loss error 
any network link can have for hydraulic convergence to occur. The default 
value of 0 indicates that no head error limit applies. Units of this 
parameter are feet (US) or meters (SI). 

Max. Flow Change Augments the ACCURACY option. Specifies the largest change in flow that 
any network element (link, emitter, or pressure- dependent demand) can 
have for hydraulic convergence to occur. The default value of 0 indicates 
that no flow change limit applies. It is specified based on the current 
project flow unit setting. 

CHECKFREQ This sets the number of solution trials that pass during hydraulic balancing 
before the status of pumps, check valves, flow control valves and pipes 
connected to tanks are once again updated. The default value is 2, 
meaning that status checks are made every other trial. A value equal to 
the maximum number of trials would mean that status checks are made 
only after a system has converged. (Whenever a status change occurs the 
trials must continue since the current solution may not be balanced.) The 
frequency of status checks on pressure reducing and pressure sustaining 
valves (PRVs and PSVs) is determined by the DAMPLIMIT option (see Table 
9-22). 

MAXCHECK This is the number of solution trials after which periodic status checks on 
pumps, check valves, flow control valves and pipes connected to tanks are 
discontinued. Instead, a status check is made only after convergence is 
achieved. The default value is 10, meaning that after 10 trials, instead of 
checking status every CHECK- FREQ trials, status is checked only at 
convergence. 

DAMPLIMIT This is the accuracy value at which solution damping and status checks on 
PRVs and PSVs should begin. Damping limits all flow changes to 60% of 
what they would otherwise be as future trials unfold. The default is 0 
which indicates that no damping should be used and that status checks on 
control valves are made at every iteration. Damping might be needed on 
networks that have trouble converging, in which case a limit of 0.01 is 
suggested. 

 
 

Table 9-22: Typical values for status checking parameters 

CHECKFREQ MAXCHECK DAMPLIMIT Remarks 

2 10 0 Frequent status checking; tends to produce 
solutions in the least number of iterations. 

10 100 0.01 Less frequent status checking; might be 
needed for networks that have difficult in 
converging. 

Max. Trials Max. Trials Convergence 
Accuracy 

Status checks made only after convergence 
is achieved; might produce convergence 
when other settings fail. 
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9.4.2 Water Quality Options 

 
Water quality options control how the water quality analysis is carried out. On the Settings toolbar 
click on the Quality button as shown in Figure 9-63 to view the water quality options that can be set. 
 

 
Figure 9-63: Quality options 

 
Select the applicable Quality Model by selecting the radio button. 
 
If Age was selected the Tolerance value (described in Table 9-23)  must be entered as show in Figure 
9-64. 
 

 
Figure 9-64: Quality model - Age 

 
If Trace was selected the Trace Node (described in Table 9-23) must be entered as show in Figure 9-65. 
 

 
Figure 9-65: Quality model - Trace 

 
If Chemical was selected, as shown in Figure 9-66, the following additional input parameters were 
required: Units, Diffusivity, Tolerance, Quality name (described in Table 9-23) and the reaction 
parameters (see Table 9-24). 
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Figure 9-66: Quality model - Chemical 

 
Table 9-23: Water quality options for water quality analysis 

Option Description 

Parameter Type of water quality parameter being modelled. Choices include: 
- None (no quality analysis) 
- Age (estimate water age) 
- Trace (percent flow from node) 
- Chemical (compute concentration) 
In lieu of Chemical, the user can enter the actual name of the chemical 
being modelled (e.g., Chlorine). 

Units Mass units used to express concentration. Choices are mg/L ug/L. 
Units for Age and Trace analyses are fixed at hours and percent, 
respectively. 

Diffusivity Ratio of the molecular diffusivity of the chemical being modelled to 
that of chlorine at 20 deg. C (0.00112 sq ft/day). Use 2 if the chemical 
diffuses twice as fast as chlorine, 0.5 if half as fast, etc. Applies only 
when modelling mass transfer for pipe wall reactions. Set to zero to 
ignore mass transfer effects. 

Tolerance Smallest change in quality that will cause a new parcel of water to be 
created in a pipe. A typical setting might be 0.01 for chemicals 
measured in mg/L as well as water age and source tracing. 

Trace Node ID label of the node whose flow is being traced. Applies only to flow 
tracing analyses. 

 
Note: The Quality Tolerance determines when the quality of one parcel of water is essentially the same 
as another parcel. For chemical analysis this might be the detection limit of the procedure used to 
measure the chemical, adjusted by a suitable factor of safety. Using too large a value for this tolerance 
might affect simulation accuracy. Using too small a value will affect computational efficiency. Some 
experimentation with this setting might be called for. 
 
Reaction options set the types of reactions that apply to a water quality analysis and are listed in Table 
9-24. 
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Table 9-24: Reaction options for water quality analysis 

Option Description 

Bulk Reaction Order Power to which concentration is raised when computing a bulk 
flow reaction rate. Use 1 for first-order reactions, 2 for second-
order reactions, etc. Use any negative number for Michaelis-
Menton kinetics. If no global or pipe-specific bulk reaction 
coefficients are assigned then this option is ignored. 

Wall Reaction Order Power to which concentration is raised when computing a bulk flow 
reaction rate. Choices are FIRST (1) for first-order reactions or ZERO 
(0) for constant rate reactions. If no global or pipe-specific wall 
reaction coefficients are assigned then this option is ignored. 

Global Bulk Coefficient Default bulk reaction rate coefficient ὑὦ assigned to all pipes. This 
global coefficient can be overridden by editing this property for 
specific pipes. Use a positive number for growth, a negative number 
for decay, or 0 if no bulk reaction occurs. Units are concentration 
raised to the (1-n) power divided by days, where n is the bulk 
reaction order. 

Global Wall Coefficient Wall reaction rate coefficient ὑύ assigned to all pipes. Can be 
overridden by editing this property for specific pipes. Use a positive 
number for growth, a negative number for decay, or 0 if no wall 
reaction occurs. Units are ft/day (US) or m/day (SI) for first-order 
reactions and mass/sq ft/day (US) or mass/sq m/day (SI) for zero- 
order reactions. 

Limiting Concentration Maximum concentration that a substance can grow to or minimum 
value it can decay to. Bulk reaction rates will be proportional to the 
difference between the current concentration and this value. Set 
to zero if not applicable. 

Wall Coefficient 
Correlation 

Factor correlating wall reaction coefficient to pipe roughness. Set 
to zero if not applicable. 

 
9.4.3 Energy Options 

 
Energy Analysis Options provide default values used to compute pumping energy and cost when no 
specific energy parameters are assigned to a given pump. The Energy Analysis Options can be set by 
clicking the Energy button on the Settings toolbar, see Figure 9-67, and the parameters that can be 
set are listed and described in Table 9-25. 
 

 
Figure 9-67: Energy options 
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Table 9-25: Energy options for hydraulic analysis 

Option Description 

Pump Efficiency (%) Default pump efficiency. 

Energy Price Price of energy per kilowatt-hour. Monetary units are not 
explicitly represented. 

Price Pattern ID label of a time pattern used to represent variations in energy 
price with time. Leave blank if not applicable. 

Demand Charge Additional energy charge per maximum kilowatt usage. 

 
9.4.4 Times 

The Times options windows, Figure 9-68, can be accessed by clicking on the Times button on the Water 
Distribution Network Model Toolbar. Times option set values for the various time steps used in an 
extended period simulation. These are listed below in Table 9-26 (times can be entered as decimal 
hours or in hours:minutes notation). 
 

 
Figure 9-68: Times options 

 
 

Table 9-26: Times Options for Hydraulic and Water Quality Analysis 

Option Description 

Total Duration Total length of a simulation in hours. Use 0 to run a single period 
(snapshot) hydraulic analysis. 

Hydraulic Time Step Time interval between re-computation of system hydraulics. Normal 
default is 1 hour. 

Quality Time Step Time interval between routing of water quality constituent. Normal 
default is 5 minutes (0:05 hours). 

Pattern Time Step Time interval used with all-time patterns. Normal default is 1 hour. 

Pattern Start Time Hours into all-time patterns at which the simulation begins (e.g., a 
value of 2 means that the simulation begins with all-time patterns 
starting at their second hour). Normal default is 0. 

Reporting Time Step Time interval between times at which computed results are reported. 
Normal default is 1 hour. 
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Option Description 

Report Start Time Hours into simulation at which computed results begin to be reported. 
Normal default is 0. 

Clock Start Time Defines the starting time of day for a simulation run, typically 
expressed in 24-hour format (e.g., 0:00, 6:00, 18:00). 

Starting Time of Day Clock time (e.g., 7:30 am, 10:00 pm) at which simulation begins. 
Default is 12:00 am (midnight). 

Statistic Type of statistical processing used to summarize the results of an 
extended period simulation. Choices are: 
None (current time step results) 
Average (time-averaged results) 
Minimum (minimum value results) 
Maximum (maximum value results) 
Range (Max-Min) 
Statistical processing is applied to all node and link results obtained 
between the Report Start Time and the Total Duration. 

 
Note: To run a single-period hydraulic analyses (also called a snapshot analysis) enter 0 for Total 
Duration. In this case entries for all of the other time options, with the exception of Starting Time of 
Day, are not used. Water quality analyses always require that a non-zero Total Duration be specified. 
 
9.4.5 Calibration Tools 

GISpipe allows the user to compare results of a simulation against measured field data. This can be 
done via Time Series plots for selected locations in the network or by special Calibration Reports that 
consider multiple locations. Before GISpipe can use such calibration data it has to be entered into a 
file and imported into the project.  
 
A Calibration File is a text file containing measured data for a particular quantity taken over a particular 
period of time within a distribution system. The file provides observed data that can be compared to 
the results of a network simulation. Separate files should be created for different parameters (e.g., 
pressure, fluoride, chlorine, flow, etc.) and different sampling studies. Each line of the file contains the 
following items: 

¶ Location ID - ID label (as used in the network model) of the location where the measurement 
was made.  

¶ Time - Time (in hours) when the measurement was made 

¶ Value - Result of the measurement 
 
See example of data set of Pressure head data shown at two nodes for a number of specific different 
times (Figure 9-70). 
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Figure 9-69: Example Calibration File 

 
The measurement time is with respect to time zero of the simulation to which the Calibration File will 
be applied. It can be entered as either a decimal number (e.g., 27.5) or in hours:minutes format (e.g., 
27:30). For data to be used in a single period analysis all time values can be 0. Comments can be added 
to the file by placing a semicolon (;) before them. For a series of measurements made at the same 
location the Location ID does not have to be repeated. 
 
The Calibration File can be imported by clicking on Calibration button on the Settings toolbar, and will 
display the observed values and compare these with the computed values as shown in Figure 9-70. 
Nodes can be added or deleted by clicking on the Add or Delete buttons. The Calibration File is added 
to the project by clicking on the Import button. Checking the Show values on map check box shows 
the results and comparison of the observed and computed values on the Viewer Map for the specific 
component. 
 

 
Figure 9-70: Calibration Data 

 
9.4.6 Adding Controls and Rules 

The Controls options windows, Figure 9-71 and Figure 9-72, can be accessed by clicking on the Controls 
button on the Water Distribution Network Model Toolbar. Controls are statements that determine 
how the network is operated over time. They specify the status of selected links as a function of time, 
tank water levels, and pressures at select points within the network.  
 
There are two categories of controls that can be used: 

¶ Simple Controls 

¶ Rule-Based Controls Simple Controls 
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A description of the setting of control statements is described in Section 9.2.6. 
 

 
Figure 9-71: Setting Simple Controls 

 

 
Figure 9-72: Setting Rule Based Controls 
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9.5 Running Simulations 

9.5.1 Setting Up a Simulation 

There are four categories of options that control how GISpipe analyses a network: Hydraulics, Quality, 
Times and Energy. To set any of these options click on the buttons on the Water Distribution Network 
Model toolbar (Figure 9-73). 
 

 
Figure 9-73: WDNM Settings 

 
Table 9-27: Simulation options 

Simulation option Description 

 

Hydraulics settings define how flow and pressure are calculated throughout 
the network, including solution accuracy, flow units, and convergence 
criteria, ensuring a reliable simulation of system behaviour, see Figure 9-62. 

 

Times settings control the duration, frequency, and scheduling of the 
simulation, aligning model results with real-world operating patterns and 
enabling time-based analysis, see Figure 9-68. 

 

Energy settings evaluate the energy consumption and cost associated with 
pump operations, supporting assessments of operational efficiency and 
optimization, see Figure 9-67. 

 

Quality settings determine how water quality constituents (e.g., chlorine, 
age, source tracing) are tracked and analysed as they move and react within 
the distribution system, see Figure 9-63. 

 
9.5.2 Run an Analysis 

To run a hydraulic/water quality analysis click on the Run Analysis button on the Analysis & Simulation 
toolbar (Figure 9-74). 
 

 
Figure 9-74: Analysis and Simulation 

 
The progress of the analysis will be displayed in a Run Status window (Figure 9-75). 
 
Click on the Close button when the analysis ends. 
 
Any error or warning messages will appear in the Run Status window. When double clicking on any 
message in the Run Status window would take the user to that component in the model. 
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Figure 9-75: Run status 

 
Model Validation 
 
Before running an analysis, users may consider running a Model Validation. This will evaluate the 
selected model and determine if there are any potential problems that could impact the successful 
analysis of the model. 
 

Click on the  button. 

If the network is correct the user will receive a message:   
 
Any potential problems will be listed, Figure 9-76, which the user can then address. 
 

 
Figure 9-76: Validation Evaluation results 
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Elevation Verification 
 
The verification of the elevations is a tool where GISpipe compares the entered elevation values of the 
objects with the Digital Elevation Model (DEM) layer values. To use this function a DEM layer needs to 
be added.  
 
In a case where no DEM is available the SRTM30M DEM from the Server could be loaded. 
 

From the Tools menu select  
 
The comparison of the DEM and the entered elevations is provided in table format as well as a 
graphical presentation of a direct comparison, see Figure 9-77. The Pipe depth can be entered to 
correct for the depth below the surface of the node as it compares it with the ground elevation from 
the DEM. 
 

 
Figure 9-77: Elevation Verification results table 

 
Network Group 
 
The Network Group feature determines the different network groups in the network model. 
 

From the Tools menu select  
 
The feature identifies all the distinct closed link groups and can organise these by colour as well as 
summarises the number of nodes, in this network and the total pipe length as shown in Figure 9-78. 
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Figure 9-78: Network Group results table 

 
Service Scope 
 
The Service Scope analysis determines the areas which are serviced by a specific Tank or Reservoir. 

From the Tools menu select  
 
The feature identifies all the distinct network sections which are supplied from a particular source 
as shown in Figure 9-79. 
 

 
Figure 9-79: Service scope analysis 
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DMA Isolation 
 
The DMA Isolation function is used to verify, manage, and simulate the isolation of district metered 
areas, ensuring they are properly bounded for operational control, leakage detection, and demand 
management. A new layer is created (DMA) and the DMA zones/shapes are drawn. 
 
The DMA Isolation function is then used to identify and simulate the hydraulic isolation of a District 
Metered Area (DMA) within the distribution network. A DMA is a defined zone in the water supply 
system, typically bounded by closed valves and monitored through bulk meters, used to measure 
inflows/outflows and manage demand and losses. 
 

Click on the  button. 
 
This will evaluate the network based on the defined DMA zones and indicate on the Viewer Map the 
different zones. If there is a zone which is linked with another DMA zone it will highlight where these 
are linked by means of a larger junction, indicating that it is supplied from the adjacent DMA zone, see 
Figure 9-80. 
 

 
Figure 9-80: DMA zones with water distribution network 

 
Advanced Analysis 
 
GISpipe provides some additional analysis option. These options can be selected from the Analysis & 
Simulation toolbar, by clicking on Advanced Analysis button, as shown in Figure 9-81. 
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Figure 9-81: Advanced Analysis options 

 
Flow Direction Analysis 
 
On the Analysis & Simulation Toolbar, click on Advance Analysis (Figure 9-81) and select Flow Direction 
Analysis from the drop-down menu to show the Flow Direction Analysis window (Figure 9-82). 
 

 
Figure 9-82: Flow Direction Analysis 

The tool identifies which links will experience a change in flow direction when the state of a particular 
link (open/closed, enabled/disabled) is modified. This helps in evaluating operational decisions, 
detecting possible backflows, and understanding the hydraulic impact of link changes on the system, 
Figure 9-83. 
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Figure 9-83: State changed link - Flow Direction Analysis 

 
Fire Hydrant Analysis 
 
On the Analysis & Simulation Toolbar, click on Advance Analysis (Figure 9-81) and select Fire Hydrant 
Analysis from the drop-down menu to show the Fire Hydrant Analysis window (Figure 9-84). 
 

 
Figure 9-84: Fire Hydrant Analysis 

 
This function is to simulate the impact of a fire hydrant on the pressures in the network. It allows users 
to test the effect of opening a fire hydrant (or simulating a sudden withdrawal of flow) on system 
pressures. The inputs and outputs are described in Table 9-28. The results are show on the Fire 
Hydrant Analysis dialogue box, Figure 9-85, and can also be seen on the map viewer window.  
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Table 9-28: Input and output of Fire Hydrant Simulation 

Parameter Description 

Input 

Junction ID The specific junction (hydrant location) where the fire flow will be 
applied. 

Demand (m³/day) The simulated fire flow demand, expressed as an outflow rate. This 
represents the volume of water withdrawn by the fire hydrant. 

Pattern An optional demand pattern to apply, if the fire flow is time-dependent 
(e.g., varying throughout the simulation). 

Start Time / End Time The simulation period during which the fire flow demand is applied. 

View Values If checked, the tool displays the calculated pressures before and after 
applying the fire hydrant demand on the map viewer window. 

Results 

Junction ID Reference to the results of the junction. 

Before Pressure The pressure at the junction before the fire flow demand is applied. 

After Pressure The pressure at the junction once the fire flow demand is applied. 

Pressure Difference The drop in pressure due to the fire hydrant withdrawal. This is the 
critical result for evaluating system resilience and firefighting capacity. 

 

 
Figure 9-85: Fire Hydrant Analysis - Results 

 
Pipe Criticality Analysis 
 
On the Analysis & Simulation Toolbar, click on Advance Analysis (Figure 9-81) and select Pipe Criticality 
Analysis from the drop-down menu to show the Pipe Criticality Analysis window (Figure 9-86). The 
input parameters and results are listed in Table 9-29. 
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Figure 9-86: Pipe Criticality Analysis 

 
Table 9-29: Input and output of Pipe Criticality Analysis 

Parameter Description 

Input 

Critical Pressure (m) The minimum allowable pressure (in meters of head) at junctions. If 
pressure falls below this threshold during a pipe closure, those 
junctions are considered impacted. Default 1 m 

Select <= Diameters A filter to include only pipes with diameters smaller than or equal to 
the specified size. This allows analysis to focus on critical smaller mains 
or laterals. 

Closures Start Time / 
Closures End Time 

Defines the period over which the pipe closure is simulated. Useful for 
extended period simulations where the timing of closures can 
influence results. 

View Values If checked, the results (pressures, number of impacted junctions, etc.) 
are displayed in map viewer window. 

Analysis Runs the pipe-by-pipe closure simulation based on the criteria above. 

Results 

Pipe ID Identifier of the pipe that was analysed for closure. 

Count of Junc. 
Impacted 

The number of junctions where pressure dropped below the specified 
critical threshold due to closure of the pipe. 

Move or Select Allows the user to either zoom to (move) or highlight (select) the 
impacted pipe in the network for further inspection. 

 
The results of a Pipe Criticality Analysis are depicted in Figure 9-87. 
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Figure 9-87: Pipe Criticality results 

 
Variable Speed Pump 
 
On the Analysis & Simulation Toolbar, click on Advance Analysis (Figure 9-81) and select Variable speed 
Pump from the drop-down menu to show the Variable Speed Pump Analysis window (Figure 9-88). 
 

 
Figure 9-88: Variable Speed Pump Analysis 
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Table 9-30: Input and output of Variable Speed Pump Analysis 

Parameter Description 

Input 

Pump ID The list of pumps in the model. Select the pump(s) to include in the variable 
speed analysis. Checkboxes used to select. 

Max. Speed The maximum allowable relative pump speed (typically expressed as a multiplier, 
ŜΦƎΦΣ άнέ ƳŜŀƴǎ ǳǇ ǘƻ ǘǿƛŎŜ ǘƘŜ ƴƻƳƛƴŀƭ ǎǇŜŜŘύΦ 

Target Junction The junction/node in the network where the pressure requirement must be 
satisfied. 

Target Pressure The required pressure (in meters of head) at the target junction. The program 
will adjust pump speed to maintain this pressure. 

Run Run button executes the analysis and generates time-step results for the selected 
pump(s). 

Results 

Pump ID Identifies the pump being analyzed (example: K3-PB1). 

Time The simulation time step (e.g., 0:00, 0:15, 0:30, etc.). 

Speed Pattern The relative pump speed multiplier required at each time step to maintain the 
target pressure at the junction (1.0 = nominal speed, >1.0 = faster, <1.0 = slower). 

Pressure The resulting pressure at the target junction when operating at the calculated 
pump speed. 

 
The results of a Pipe Criticality Analysis are depicted in Figure 9-89. 
 

 
Figure 9-89: Variable Speed Pump Analysis results 
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9.5.3 Viewing Status and Errors 

GISpipe will issue specific Error and Warning messages when problems are 
encountered in running a hydraulic/water quality analysis (see Appendix D 
for a complete listing). The most common problems are discussed below.  

 
Pumps cannot deliver flow or head 
GISpipe will issue a warning message when a pump is asked to operate outside the range of its pump 
curve. If the pump is required to deliver more head than its shutoff head, GISpipe will close the pump 
down. This might lead to portions of the network becoming disconnected from any source of water. 
 
Network is disconnected 
GISpipe classifies a network as being disconnected if there is no way to provide water to all nodes that 
have demands. This can occur if there is no path of open links between a junction with demand and 
either a reservoir, a tank, or a junction with a negative demand. If the problem is caused by a closed 
link GISpipe will still compute a hydraulic solution (probably with extremely large negative pressures) 
and attempt to identify the problem link in its Status Report. If no connecting link(s) exist GISpipe will 
be unable to solve the hydraulic equations for flows and pressures and will return an Error 110 
message when an analysis is made. Under an extended period simulation, it is possible for nodes to 
become disconnected as links change status over time. 
 
Negative pressures exist 
When performing a demand driven analysis (DDA), GISpipe will issue a warning message when it 
encounters negative pressures at junctions that have positive demands. This usually indicates that 
there is some problem with the way the network has been designed or operated. Negative pressures 
can occur when portions of the network can only receive water through links that have been closed 
off. In such cases an additional warning message about the network being disconnected is also issued. 
Alternatively, a pressure driven analysis (PDA) can be performed to determine a hydraulic solution 
assuming a pressure-demand relationship at junctions. The hydraulic solution found will have reduced 
ƻǊ ȊŜǊƻ ŘŜƳŀƴŘǎ ŀƴŘ ƴŜƎŀǘƛǾŜ ǇǊŜǎǎǳǊŜǎ ǿƛƭƭ ōŜ ƭŀǊƎŜƭȅ ŜƭƛƳƛƴŀǘŜŘΦ ¢Ƙƛǎ ƛǎ ŎƻƴǎƛŘŜǊŜŘ ŀ ƳƻǊŜ άǊŜŀƭƛǎǘƛŎέ 
solution since large negative pressures in a network are not physically realistic. 
 
System unbalanced 
A system unbalanced condition can occur when GISpipe cannot converge to a hydraulic solution in 
some time period within its allowed maximum number of trials. This situation can occur when valves, 
pumps, or pipelines keep switching their status from one trial to the next as the search for a hydraulic 
solution proceeds. For example, the pressure limits that control the status of a pump may be set too 
ŎƭƻǎŜ ǘƻƎŜǘƘŜǊΦ hǊ ŀ ǇǳƳǇΩǎ ƘŜŀŘ ŎǳǊǾŜ ƳƛƎƘǘ ōŜ ǘƻƻ Ŧƭŀǘ ŎŀǳǎƛƴƎ ƛǘ ǘƻ ƪŜŜǇ ǎƘǳǘǘƛƴƎ ƻƴ ŀƴŘ ƻŦŦΦ ¢ƻ 
eliminate the unbalanced condition one can, try to increase the allowed maximum number of trials or 
ƭƻƻǎŜƴ ǘƘŜ ŎƻƴǾŜǊƎŜƴŎŜ ŀŎŎǳǊŀŎȅ ǊŜǉǳƛǊŜƳŜƴǘΦ .ƻǘƘ ƻŦ ǘƘŜǎŜ ǇŀǊŀƳŜǘŜǊǎ ŀǊŜ ǎŜǘ ǿƛǘƘ ǘƘŜ ǇǊƻƧŜŎǘΩǎ 
Hydraulic Options. If the unbalanced condition persists, then another hydraulic option, labelled άLŦ 
UnbaƭŀƴŎŜŘέΣ ƻŦŦŜǊǎ ǘǿƻ ǿŀȅǎ ǘƻ ƘŀƴŘƭŜ ƛǘΦ 
 

1. One is to terminate the entire analysis once the condition is encountered.  
2. The other is to continue seeking a hydraulic solution for another 10 trials with the status of all 

links frozen to their current values. If convergence is achieved then a warning message is 
issued about the system possibly being unstable. If convergence is not achieved then a 
ά{ȅǎǘŜƳ ǳƴōŀƭŀƴŎŜŘέ ǿŀǊƴƛƴƎ ƳŜǎǎŀƎŜ ƛǎ ƛǎǎǳŜŘΦ Lƴ ŜƛǘƘŜǊ ŎŀǎŜΣ ǘƘŜ ŀƴŀƭȅǎƛǎ ǿƛƭƭ ǇǊƻŎŜŜŘ ǘƻ 
the next time period. 
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If an analysis in a given time period ends with the system unbalanced then the user should recognize 
that the hydraulic results produced for this time period are inaccurate. Depending on circumstances, 
such as errors in flows into or out of storage tanks, this might affect the accuracy of results in all future 
periods as well. 
 
Hydraulic equations unsolvable 
Error 110 is issued if at some point in an analysis the set of equations that model flow and energy 
balance in the network cannot be solved. This can occur when some portion of a system demands 
water but has no links physically connecting it to any source of water. In such a case GISpipe will also 
issue warning messages about nodes being disconnected. The equations might also be unsolvable if 
unrealistic numbers were used for certain network properties. 
 

9.6 Viewing and Interpreting Results 

There are several ways in which database values and results of a simulation can be viewed directly on 
the Viewer Map. On the Analysis & Simulation toolbar drop down lists allows the selection of object, 
parameter and elements to visualise (see Figure 9-90). 

 

 
Figure 9-90: View results option toolbar 

 
The Viewing options that can be selected and set are shown in Figure 9-91. 
 
There are three types of map legends that can be displayed. The Node and Link Legends associate a 
colour with a range of values for the current parameter being viewed on the map (see Figure 9-92). 
The Time Legend displays the clock time of the simulation time period being viewed. To display the 
legend, select the parameter and to hide any of these legends double click with the left mouse button 
on the specific legend. 
 
To move a legend to another location: 

¶ Press the left mouse button over the legend. 

¶ With the button held down, drag the legend to its new location and release the button. 
 
To edit the Node Legend: 
1. Right-click on the legend if it is visible. 
2. Use the Legend Editor dialog form that appears (see Figure 9-93ύ ǘƻ ƳƻŘƛŦȅ ǘƘŜ ƭŜƎŜƴŘΩǎ colours and 
intervals. 
A similar method is used to edit the Link Legend. 
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Figure 9-91: Viewing options 
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Setting Nodes view to Pressure 

 
Setting Links view to Flow 

 
Setting Contour view to Elevation 

Figure 9-92: Legend options 

 
The Legend Editor (Figure 9-93) is used to set numerical ranges to which different colours are assigned 
for viewing a particular parameter on the network map. It works as follows: 

¶ Numerical values, in increasing order, are entered in the edit boxes to define the ranges. Not 
all four boxes need to have values. 

¶ To change a colour, click on its colour band in the Editor and then select a new colour from 
the Colour Dialog box that will appear. 

¶ Click the Equal Intervals button to assign ranges based on dividing the range of the parameter 
at the current time period into equal intervals. 

¶ Click the Equal Quantiles button to assign ranges so that there are equal numbers of objects 
within each range, based on values that exist at the current time period. 

¶ The Reverse Colours button reverses the ordering of the current set of colours (the colour in 
the lowest range becomes that of the highest range and so on). 

 

 
Figure 9-93: Legend Editor 

 
A description of the options that could be displayed as shown in Figure 9-91 is listed in Table 9-31 and 
shown in an example in Figure 9-94. 
 
Table 9-31: Display options on Viewer Map 

Option Description 

Nodes 

Layer - Junction Toggles visibility of junctions on the map 

Layer - Reservoir Toggles visibility of reservoirs on the map 

Layer - Tank Toggles visibility of tanks on the map 

Node Values Displays computed results (e.g., pressure, head) at each node 

Node ID's Displays identification labels for nodes 

Size - Node Size Controls the display size of nodes 



 

GISpipe ς User manual 98 

Option Description 

Size - Size by Value 
Adjusts node size dynamically based on hydraulic or quality 
values 

Size - Font Size Sets font size for node-related labels 

Decimals - Demand Sets decimal places for demand values at nodes 

Decimals - Head Controls decimal precision for hydraulic head values 

Decimals - Pressure Controls decimal places for pressure values 

Decimals - Quality Sets decimal precision for water quality at nodes 

Links 

Layer - Pipe Toggles visibility of pipes on the map 

Layer - Pump Toggles visibility of pumps on the map 

Layer - Valve Toggles visibility of valves on the map 

Link Values Displays computed values (e.g., flow, velocity) on each link 

Link ID's Displays the identification labels of links 

Flow Direction Shows arrows indicating direction of flow in pipes 

Size - Link Size Sets the display thickness of links on the map 

Size - Size by Value Adjusts link thickness dynamically based on hydraulic values 

Size - Font Size Sets font size for link-related labels 

Decimals - Flow Sets the number of decimal places shown for flow 

Decimals - Velocity Sets decimal precision for velocity values 

Decimals - Unit Headloss Controls decimal places for headloss per unit length 

Decimals - Friction Factor Controls display precision of the pipe friction factor 

Decimals - Reaction Rate Sets decimals for chemical reaction rates in links 

Decimals - Quality Sets decimal precision for water quality in links 

Contours 

Export to Layer 
Exports contour map to a GIS layer for visualization or further 
processing 

Resolution (Pixel) Sets the pixel resolution for the exported contour map 

Style Chooses between Filled or Line contour styles for the map 

Thickness Defines the line thickness for contour lines 

Lines per Level Specifies how many lines are drawn per contour level 
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Figure 9-94: Map view hydraulic analysis results 

 
The results as displayed in the map view is based on the simulation for that specific analysis period. 
The specific time period that the user wants to display can be selected from the timeline shown at the 
bottom of the screen, simply click on the time period block. 
 
Alternatively, the time period can be selected from the drop-down list in the Time Controller (Figure 
9-95).  
 
The user also has the option to view an animation of the changes which occurs in the distribution 
network. The buttons in the Timer control can animate the map through time. Click the Forward 
button to start the animation and the Stop button to stop it. Click the Option button to view the 
Simulated Speed which can be set on the slider bar (+ increase or ς decrease). 
 

 
Figure 9-95: Time controller 

 
The timeline at the bottom of the Map Viewer area will show each of the time periods analysed. If a 
block is light blue it indicates that there were some of the nodes that have experienced negative 
pressures during that period. Double-click the left mouse button on the block to reveal all the locations 
where negative pressures were experienced in the network as shown in Figure 9-96. 



 

GISpipe ς User manual 100 

 
Figure 9-96: Extended Period Simulation - Results 

 
 
9.6.1 Viewing Results with a Graph 

Analysis results, as well as some design parameters, can be viewed using several different types of 
graphs. Graphs can be printed, copied to the Windows clipboard, or saved as a data file or Windows 
metafile. Table 9-32 lists the types of graphs that can be used to view values for a selected parameter. 
 
 

Table 9-32: Types of Graphs Available to View Results 

Type of plot Description Applies to 

Time Series Graph 
Plots value versus time (Examples 
shown in Figure 9-97 and Figure 9-99) 

Specific nodes or links over all 
time periods 

Profile Graph 
Plots value versus distance (Example 
shown in Figure 9-100) 

A list of nodes at a specific time 

Frequency Graph 

Plots value versus fraction of objects 
at or below the value (Example 
shown in Figure 9-101 and Figure 
9-102) 

All nodes or links at a specific 
time or for all analysed time 
periods 

Contour Plot 
Shows regions of the map where 
values fall within specific intervals 

All nodes at a specific time 

 
Time Series graphs and Profile graphs require one or more objects be selected for plotting. To select 
items into the Time Series or Profile Graphs for plotting: 

¶ Select the object (node or link) on the Viewer Map. (Time Series Graph Window will remain 
visible during this process). 

¶ Click the Add button on the Time Series Graph Window to add the selected item to the list. 
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Time Series Graph 
 
The parameters which can be selected to plot in a Time Series graph are listed in Table 9-33. 
 
Table 9-33: Time series graph parameters 

Object Parameter 

Nodes 
(Figure 9-97) 

Actual Demand 
Total Head 
Pressure 
Quality 
Demand Deficit (PDA) 
Pressure Deficit (PDA) 

Links 
(Figure 9-99) 

Flow 
Velocity 
Unit headloss 
Friction factor 
Reaction rate 
Quality 
Status 

 
An example of a Time Series Graph of nodes and the Pressure vs Time of 3 selected junctions is  
depicted in Figure 9-97.  
 
The added nodes can also be selected and deleted by clicking on the Delete button and new nodes 
can be added by clicking on the Add button.  
 
Clicking in the check boxes in the legend above the graph will show or hide the selected node.  
 
The order of the selected nodes can also be changed by clicking on the Move Up or Move Down 
buttons. 
 
Clicking the Table Tab (see Figure 9-97) switches to the same selected nodes but shows the results in 
table format as show in Figure 9-98. 
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Figure 9-97: Time Series graph - Nodes 

 

 
Figure 9-98: Time Series graph - Nodes - Table format 
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Figure 9-99: Time Series graph - Links 

 
Profile Graph 
 
To generate a Profile Graph the start and end node should be selected. Click on the Start node and 
then the Add button, select the end node and click on the Add button. All the nodes in between these 
nodes are automatically added and the graph is automatically drawn as shown in Figure 9-100.  
 

 
Figure 9-100: Profile graph 
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The graph displays the Min. Total Head, Avg. Total Head, Max. Total Head, Pipe and Elevation with 
option in the legend to display or hide through the toggle buttons. 
 
The user also has the option to reverse the direction of the profile plot by clicking on the Reverse 
button. Clicking on the Clear button will delete all the displayed nodes and show a clear graph. 
 
Frequency Graph 
 
The Frequency Graph displays the value versus fraction of objects at or below the value as shown in 
Figure 9-101 and Figure 9-102. 
 

 
Figure 9-101: Frequency graph ς Nodes - Pressure (Current time) 

 

 
Figure 9-102: Frequency graph ς Links - Velocity (All time) 
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When drawing the frequency plot the user has the option to set the Type: 

¶ All network  

¶ Selected network 
This will allow user to select only a section of the network for which a frequency diagram is required 
 
When drawing the frequency plot the user has the option to set the Time: 

¶ Current time (see Figure 9-101) 

¶ All time (see Figure 9-102) 
This will allow user to select only a specific time period or draw a frequency diagram with all the time 
periods analysed. 
 
Table 9-34: Frequency graph parameters 

Object Parameter 

Nodes 
(Figure 9-101) 

Elevation 
Base Demand 
Initial Quality 
Actual Demand 
Total Head 
Pressure 
Quality 

Links 
(Figure 9-102) 

Length 
Diameter 
Roughness 
Bulk coefficient 
Wall coefficient 
Flow 
Velocity 
Unit headloss 
Friction factor 
Reaction rate 
Quality 

 
Note: A Time Series, Profile, or Frequency Graph can be zoomed by holding down the Shift key while 
ŘǊŀǿƛƴƎ ŀ ȊƻƻƳ ǊŜŎǘŀƴƎƭŜ ǿƛǘƘ ǘƘŜ ƳƻǳǎŜΩǎ ƭŜŦǘ ōǳǘǘƻƴ ƘŜƭŘ ŘƻǿƴΦ 5ǊŀǿƛƴƎ ǘƘŜ ǊŜŎǘŀƴƎƭŜ ŦǊƻƳ ƭŜŦǘ ǘƻ 
right zooms in, drawing from right to left zooms out. The graph can also be panned in any direction by 
holding down the Ctrl key and moving the mouse across the plot with the right button held down. 
 
Right click anywhere on the Graph (Figure 9-97, Figure 9-99 and Figure 9-101) will show the various 
options to modify the General look (colours, views and title), Horizontal Axis (minimum, maximum, 
increments, grid lines & title), Vertical Axis (minimum, maximum, increments, grid lines & title), 
Legend (position, colour, size, framed & visibility) and Series (series, title, symbology of lines, markers 
and labels) as depicted in Figure 9-103.  
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Figure 9-103: Graph options 

 
The options contained on each tab of the Graph Options dialog window are described below in Table 
9-35. 
 
 

Table 9-35: Graph Options General, Horizontal and Vertical Axis and Legend Tabs 

Option Description 

General 

Panel Colour Colour of the panel ǿƘƛŎƘ ǎǳǊǊƻǳƴŘǎ ǘƘŜ ƎǊŀǇƘΩǎ ǇƭƻǘǘƛƴƎ ŀǊŜŀ 

Background Colour ColouǊ ƻŦ ƎǊŀǇƘΩǎ ǇƭƻǘǘƛƴƎ ŀǊŜŀ 

View in 3D Check if graph should be drawn in 3D 

3D Effect Percent Degree to which 3D effect is drawn 

Main Title ¢ŜȄǘ ƻŦ ƎǊŀǇƘΩǎ Ƴŀƛƴ ǘƛǘƭŜ 

Font Changes the font used for the main title 

Horizontal and Vertical Axis 

Minimum Sets minimum axis value (minimum data value is shown in 
parentheses). Can be left blank. 

Maximum Sets maximum axis value (maximum data value is shown in 
parentheses). Can be left blank. 

Increment Sets increment between axis labels. Can be left blank. 

Auto Scale If checked then Minimum, Maximum, and Increment settings are 
ignored. 

Gridlines Selects type of gridline to draw. 

Axis Title Text of axis title 

Font Click to select a font for the axis title. 

Legend 

Position Selects where to place the legend. 
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Option Description 

Colour Selects colour to use for legend background. 

Symbol Width Selects width to use (in pixels) to draw symbol portion of the legend. 

Framed Places a frame around the legend. 

Visible Makes the legend visible. 

Position Selects where to place the legend. 
 

 
Click the Font button to change the font used for the legend. (Other legend properties are selected on 
the Legend page of the dialog.) 
 
Select a property of the data series you would like to modify. The choices are: Lines, Markers, Patterns 
and Labels. (Not all properties are available for some types of graphs.) 
 
The data series properties that can be modified on the Series tab are listed in Table 9-36. 
 
Table 9-36: Graph Options Series Tab 

Category Option Description 

Lines Style Selects line style. 

Colour Selects line colour. 

Size Selects line thickness (only for solid line style). 

Visible Determines if line is visible. 

Markers Style Selects marker style. 

Colour Selects marker colour. 

Size Selects marker size. 

Visible Determines if marker is visible. 

Patterns Style Selects pattern style. 

Colour Selects pattern colour. 

Stacking Not used with GISpipe. 

Labels Style Selects what type of information is displayed in the label. 

Colour {ŜƭŜŎǘǎ ǘƘŜ ŎƻƭƻǳǊ ƻŦ ǘƘŜ ƭŀōŜƭΩǎ ōŀŎƪƎǊƻǳƴŘΦ 

Transparent Determines if graph shows through label or not. 

Show Arrows Determines if arrows are displayed on pie charts. 

Visible Determines if labels are visible or not. 

 
Contour plot 
 
Using the View results option toolbar, Figure 9-90, the user can select to show the contours. This is a 
for example a very useful plot to identify specific areas of high or low pressures as shown in Figure 
9-104. 
 
The created contour map can also be exported to a separate layer by clicking on the Export to Layer 
option see Figure 9-91.  
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Figure 9-104: Contour plot 

 
9.6.2 Viewing Results in Tables 

There are numerous ways to generate and view the results in table format. When viewing a graph 
(Figure 9-97), clicking the Table Tab switches to the same selected nodes but shows the results in table 
format as show in Figure 9-98. 
 
Alternatively selecting the junctions and/or links on the Map viewer window, right clicking on the 
window and selecting View Selected Shapes Table from the pop-up menu, see Figure 9-105, will show 
the results in a table format, as shown in Figure 9-106. 
 

 
Figure 9-105: Selecting junctions and pipes 
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Figure 9-106: Viewing results in table format 

 
It must be remembered that the results shown would only be for the specific time step in an extended 
period simulation. 
 
9.6.3 Exporting Simulation Results 

On the Report Toolbar click on the Export button to save all the simulated results to a Microsoft Excel 
file, Figure 9-107.  
 

 
Figure 9-107: Export to Microsoft Excel - Results 
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9.6.4 Pipes report 

On the Report Toolbar click on the Pipes button to view the water pipes results, Figure 9-108. The 
results in each of the columns are listed in Table 9-37. 
 

 
Figure 9-108: Pipes report 

 
Table 9-37: Pipes report results 

Column Description 

Asset ID Unique identifier for the pipe, usually linked to the GIS asset register 

Type Classification of the pipe (e.g., Water Distribution) 

Material Pipe construction material 

Diameter Internal diameter of the pipe 

Length Length of the pipe segment 

Install Year Year the pipe was installed, used for age tracking and renewal planning 

Valve Count Number of valves located on or associated with the pipe 

Supply Count Number of direct customer connections served by the pipe 

Supply Length Total length of service connections attached to the pipe  

Max Pressure Maximum pressure experienced in the pipe during simulation 

DMA Name District Metered Area (DMA) that the pipe belongs to 

Service No Number of individual service connections (customer meters) linked to the pipe 

 
9.6.5 Energy report 

On the Report Toolbar click on the Energy button to view the Energy Report results, Figure 9-109. This 
report summarizes the energy performance of pumps in the network, helping identify high energy 
users, inefficient pumps, and opportunities for cost savings. 
 
The results in each of the columns are listed in Table 9-38. 
 
Selecting the Graph Tab (Figure 9-109), provides a visual comparison of energy and efficiency 
performance across all pumps in the system, making it easy to identify the most energy-intensive or 
least efficient pumps, see Figure 9-110. This is done by providing 5 different graph options similar to 
that in Table 9-38. 
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Figure 9-109: Energy Report - Table output 

 
Table 9-38: Energy reports - Output 

Field Description 

Pump Identifier of the pump being analysed 

Percent Utilization Percentage of the total simulation time that the pump was operating 

Average Efficiency Average hydraulic-to-mechanical efficiency (%) of the pump during 
operation. 

kW-hr/m³ Energy consumed per unit volume of water pumped (kilowatt-hours per 
cubic metre) 

Average kWatts Average power consumption (kW) of the pump over the simulation period 

Peak kWatts Maximum (peak) power demand (kW) recorded during the simulation 

Cost/day Daily cost of operating the pump, based on energy consumption and tariff 
data 

 

 
Figure 9-110: Energy Report - Graph output 
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9.7 Other Features 

On the Results Toolbar click on the Export button to save all the simulated results to a Microsoft Excel 
file, Figure 9-107.  
 

 
Figure 9-111: Other Features 

 
9.7.1 Bulk Coefficient 

The Bulk Coefficient window, as shown in Figure 9-112, helps users determine how the bulk reaction 
coefficient (Kb), used in water quality modelling, changes with temperature. This is especially relevant 
for chlorine decay and other disinfectant reactions. 
 
This tool is selected by clicking on the Other Features button on the Analysis & Simulation toolbar and 
then click on the Bulk Coefficient button. 
 

 
Figure 9-112: Bulk Coefficient 

 
A detailed breakdown of the inputs and outputs are listed in Table 9-39. 
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Table 9-39: Input and output of Bulk Coefficient 

Parameter Description 

Input 

Time (hr) The elapsed time of the test, in hours, for chlorine decay 
measurements. 

/ƭі όƳƎκ[ύ The measured chlorine concentration at that time step. These values 
are typically obtained from laboratory or field tests where a water 
sample is monitored over time. 

Temperature (°C) The temperature at which the chlorine decay test is performed. 
Multiple sets of decay tests can be run at different temperatures to 
establish temperature dependence. 

Add This button adds a new row of input data (time, chlorine concentration, 
and temperature). 

Delete Removes a selected row of input data. 

Temperature (°C) Sets or edits the test temperature associated with the dataset. 

Kb Calculate Runs the regression analysis to calculate the bulk reaction coefficient 
(Kb) for each dataset. 

Results 

DǊŀǇƘ ό/ƭі Ǿǎ ¢ƛƳŜύ Displays chlorine concentration decay over time for the entered 
dataset. The slope of the decay curve is used to estimate the bulk 
coefficient. 

Graph (ln Kb vs 
1000/T) 

Plots the natural logarithm of the bulk coefficient against inverse 
temperature (Arrhenius plot). This shows how reaction rates depend 
on temperature and allows extrapolation to other temperatures. 

/ŀƭŎǳƭŀǘŜŘ Yō όŘŀȅѐцύ The computed bulk reaction coefficient, shown numerically after 
analysis. This coefficient is then used in water quality simulations (e.g., 
chlorine decay modelling). 

 
9.7.2 Skelebrator 

The Skelebrator tool, as shown in Figure 9-113, is used to simplify a complex water distribution 
network by selectively removing less significant parts of the system. This process is commonly referred 
to as network skeletonization, and it helps reduce computational complexity while retaining the 
essential hydraulic characteristics of the network. 
 
This tool is selected by clicking on the Other Features button on the Analysis & Simulation toolbar and 
then click on the Skelebrator button. 
 
The Skelebrator simplifies the network by: 

¶ Removing pipes with diameters smaller than a user-defined threshold. 

¶ Merging junctions where there are minimal elevation differences. 

¶ Focusing either on the entire network or a selected portion. 
 
This is especially useful for large, detailed models where a more abstracted version is needed for 
planning or scenario analysis. The information required to apply the skeletonization is listed in Table 
9-40. 
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Figure 9-113: Skelebrator option 

 
Table 9-40: Skelebrator input 

Option Description 

Extent of 
Skeletalization 

Choose between applying simplification to the entire network or just a 
selected portion. 

Diameter Select, from a dropdown list, the pipes with diameters smaller than this value 
that should be removed from the model. 

Pipe Merge When enabled, the software merges connected pipes at junctions where the 
elevation change is minor. 

Elevation less than Specifies the elevation difference threshold below which junctions can be 
merged. 

 
9.7.3 Flow Units Conversion 

This tool is selected by clicking on the Other Features button on the Analysis & Simulation toolbar and 
then click on the Flow Units Conversion button. The project is set to a specific flow unit (see Appendix 
B). This tool allows the user to change the units and, in this process, change all the demand values to 
the new units. The Flow Units Conversion window, Figure 9-114, will show the current flow units 
(Source Units) and provide a drop-down list (Target Units) of flow units that the user can select from. 
Click on the Ok button to confirm the conversion. 
 

 
Figure 9-114: Flow unit conversion 
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9.7.4 Pipe Length Recalculation 

This tool is selected by clicking on the Other Features button on the Analysis & Simulation toolbar and 
then click on the Recalculating Pipe Length button. Based on the scale all pipe length will be 
recalculated. Once complete a confirmation pop-up window will be shown, Figure 9-115, to confirm 
the procedure. 
 

 
Figure 9-115: Completed Pipe Recalculating Length procedure 

 
9.7.5 Add Valve to Net 

Valves can be added to the network model by importing a valve layer with the positions of the valves. 
The valve can be selected in the Viewer map see Figure 9-116. 
 

 
Figure 9-116: Selecting a valve on the Valve layer 

  
 
This Add Valve to Net tool is selected by clicking on the Other Features button on the Analysis & 
Simulation toolbar and then click on the Add Valve to Net button. The valve will be inserted into the 
network model as shown in Figure 9-117 . 
 

 
Figure 9-117: Valve added to network 

 
9.7.6 Pipe Depth to EPANET Elevation 

This tool is selected by clicking on the Other Features button on the Analysis & Simulation toolbar and 
then click on the Pipe Depth Layer -> EPAnet Elevation button. This function automatically converts 
GIS pipe depth and surface elevation data into EPANET junction elevations, ensuring the hydraulic 
model reflects real-world ground levels. 
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From GIS elevation data (DEM, contour layers, or pipe survey data), the surface elevation at each 
pipe/junction location is determined. A Pipe Depth layer is required and when the network model is 
selected click on the Pipe Depth Layer -> EPAnet Elevation button to show the dialogue box shown in 
Figure 9-115. Select if the information should be extracted from the DEM or the pipe depth data layer. 
Select if the entire network (All Network radio button) or only a Selected Network should be modified. 
 

 
Figure 9-118: Pipe Depth Layer -> EPAnet Elevation tool 

 

9.8 Optimization 

On the Optimization toolbar there are two options to select from Roughness and Wall Coeff. 
 
9.8.1 Roughness automatic calibration 

Selecting Roughness shows the Roughness automatic calibration window as depicted in Figure 9-119. 
The various input and results parameters are listed in Table 9-41. 
 

 
Figure 9-119: Roughness Automatic Calibration window 
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Table 9-41: Roughness automatic calibration 

Field / Control Description 

Pipe Data 

Pipe ID Unique identifier of each pipe in the network 

Diameter Pipe internal diameter 

Material Pipe material type (e.g., MOP001, PVC/PE) 

Install Year Year the pipe was installed, used for age-based grouping 

Velocity under peak flow Simulated velocity in the pipe at peak demand 

Before Roughness Initial/default roughness value before calibration 

Current Roughness Updated/calibrated roughness value after running the tool 

Range Options 

All Pipes Apply calibration to the entire network 

Selected Pipes Apply calibration only to highlighted/selected pipes 

Grouping Options 

Diameter Groups pipes by diameter for calibration 

Material Groups pipes by material type 

Install Year Groups pipes by age; interval controlled by Year Interval field. 

Year Interval Interval in years for grouping (e.g., 5 years) 

Velocity under peak flows Groups pipes by velocity; interval controlled by Velocity Interval field. 

Velocity Interval Interval in m/s for velocity grouping (e.g., 0.5 m/s) 

Constraints 

Max. Roughness Maximum allowable calibrated roughness value 

Min. Roughness Minimum allowable calibrated roughness value 

PVC/PE Max. Roughness Maximum roughness allowed for PVC/PE pipes 

PVC/PE Min. Roughness Minimum roughness allowed for PVC/PE pipes 

Pipe Material Selector Enables setting constraints for specific pipe materials (e.g., MOP001) 

Analyse 

Run Executes the automatic calibration process 

Apply Applies the updated/calibrated roughness values to the model 

Results 

RMSE Graph Displays Root Mean Square Error between observed and simulated data 
(fit check). 

Current Roughness 
(updated) 

Shows the final calibrated roughness values in the table. 

 
9.8.2 Wall coefficient automatic calibration 

Selecting Wall Coeff. shows the Wall Coefficient Automatic Calibration window as depicted in Figure 
9-120. The various input and results parameters are listed in Table 9-42. 
 
 



 

GISpipe ς User manual 118 

 
Figure 9-120: Wall Coefficient Automatic Calibration window 

 
Table 9-42: Wall coefficient automatic calibration 

Field / Control Description 

Pipe Data 

Pipe ID Unique identifier of each pipe in the network 

Diameter Pipe internal diameter 

Material Pipe material type (e.g., MOP001, PVC/PE) 

Install Year Year the pipe was installed, used for age-based grouping 

Velocity under peak flow Simulated velocity in the pipe at peak demand 

Before Wall Coeff. Initial/default wall reaction coefficient before calibration 

Current Wall Coeff. Updated/calibrated wall reaction coefficient after running the tool 

Range Options 

All Pipes Apply calibration to the entire network 

Selected Pipes Apply calibration only to highlighted/selected pipes 

Grouping Options 

Diameter Groups pipes by diameter for calibration 

Material Groups pipes by material type 

Install Year Groups pipes by age; interval controlled by Year Interval field 

Year Interval Interval in years for grouping (e.g., 5 years) 

Velocity under peak flows Groups pipes by velocity; interval controlled by Velocity Interval field 

Velocity Interval Interval in m/s for velocity grouping (e.g., 0.5 m/s) 

Constraints 

Min. Wall Coeff. Minimum allowable wall reaction coefficient (e.g., ς0.5) 

Max. Wall Coeff. Maximum allowable wall reaction coefficient 

Analyse 

Run Executes the automatic calibration process 

Apply Applies the updated/calibrated wall coefficients to the model 

Results 

RMSE Graph Displays Root Mean Square Error between observed and simulated 
data (fit check) 

Current Wall Coeff. (updated) Shows the final calibrated wall reaction coefficient values in the table 
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10 STORM WATER MANAGEMENT MODEL (To be completed) 

GISpipe integrates the EPA Storm Water Management Model (SWMM) into a Geographical 
Information System environment. This creates a dynamic rainfall-runoff simulation model used for 
single event or long-term (continuous) simulation of runoff quantity and quality from primarily urban 
areas running on a GIS platform. The runoff component of SWMM operates on a collection of 
subcatchment areas that receive precipitation and generate runoff and pollutant loads (Figure 10-1). 
The routing portion of SWMM transports this runoff through a system of pipes, channels, 
storage/treatment devices, pumps, and regulators. SWMM tracks the quantity and quality of runoff 
generated within each subcatchment, and the flow rate, flow depth, and quality of water in each pipe 
and channel during a simulation period comprised of multiple time steps. Running under Windows, 
SWMM 5 provides an integrated environment for editing study area input data, running hydrologic, 
hydraulic and water quality simulations, and viewing the results in a variety of formats. These include 
colour-coded drainage area and conveyance system maps, time series graphs and tables, profile plots, 
ŀƴŘ ǎǘŀǘƛǎǘƛŎŀƭ ŦǊŜǉǳŜƴŎȅ ŀƴŀƭȅǎŜǎΦ ¢Ƙƛǎ ǳǎŜǊΩǎ Ƴŀƴǳŀƭ ŘŜǎŎǊƛōŜǎ ƛƴ ŘŜǘŀƛƭ Ƙƻǿ ǘƻ Ǌǳƴ GISpipe built 
storm water management models. It includes instructions on how to build a drainage system model, 
how to set various simulation options, and how to view results in a variety of formats. It also describes 
the different types of files used by SWMM and provides useful tables of parameter values. Detailed 
descriptions of the theory behind SWMM 5 (the engine used in GISpipe) and the numerical methods 
it employs can be found in a separate set of reference manuals (www.epa.gov/water-research/storm-
water-management-model-swmm). 
 

 
Figure 10-1: SWMM (USEPA, 2022) 

 
SWMM is used throughout the world for planning, analysis, and design related to stormwater runoff, 
combined and sanitary sewers, and other drainage systems. It can be used to evaluate gray 
infrastructure stormwater control strategies, such as pipes and storm drains, and is a useful tool for 
creating cost-effective green/gray hybrid stormwater control solutions. SWMM was developed to help 
support local, state, and national stormwater management objectives to reduce runoff through 
infiltration and retention, and help to reduce discharges that cause impairment of waterbodies. 
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10.1 DL{ǇƛǇŜΩǎ ŎƻƴŎŜǇǘǳŀƭ ƳƻŘŜƭ 

10.2 DL{ǇƛǇŜΩǎ Ƴŀƛƴ ǿƛƴŘƻǿ 

10.3 Working with projects 

10.4 Working with objects 

10.5 Working with the viewer map 

10.6 Running a simulation 

10.7 Viewing results 

10.8 Files used by GISpipe 
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11 SURFACE RUNOFF MODEL (To be completed) 

When working on Surface Runoff Models selecting Surface Runoff Model Menu will show the analysis 
and viewing functions associated with the surface runoff model as shown in Figure 11-1. 
 

 
Figure 11-1: Tool bar options when selecting the Surface Runoff Model Menu 
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12 TOOLS 

Selecting the Tools menu will provide the user with specific tools related to the DEM data, Shapefiles 
and generating of basins or streams as shown in Figure 12-1 with descriptions listed in Table 12-1. 
 

 
Figure 12-1: Tool bar options when selecting the Tools Menu 

 
Table 12-1: Layer tools 

Icon Description 

 

 
 

Downloads 30-meter resolution Digital Elevation Model (DEM) data from 
an online SRTM (Shuttle Radar Topography Mission) server. This provides 
elevation data for the selected geographic area and is typically used for 
terrain analysis or hydraulic modelling. 

 

 
 

Creates a DEM surface from available elevation data (e.g., points, 
contours). This is useful for analysing topography, drainage paths, and 
basin delineation in water distribution planning. 

 

 
 

Creates a DEM surface from available elevation data (e.g., points, 
contours). This is useful for analysing topography, drainage paths, and 
basin delineation in water distribution planning. 

 

 
 

Converts raster data (pixel-based images such as scanned maps or DEMs) 
into vector features (points, lines, polygons). Typically used to digitize 
features like pipelines, roads, or contours from a background image. 

 

 
 

Transforms coordinate data stored in an Excel file (e.g., node coordinates, 
elevations) into a shapefile format. This enables integration with GIS 
systems and spatial analysis workflows. 
 

 

 
 

Assigns elevation values to nodes or junctions in the water distribution 
model, either manually or based on DEM data. Accurate elevation data is 
crucial for hydraulic modelling. 

 

 
 

Imports building footprints or structural data from web-based GIS services 
(e.g., OpenStreetMap). This helps visualize infrastructure and assess 
impacts in urban water modelling. 

 

 
 

Creates a Voronoi (Thiessen) polygon layer based on junctions or nodes. 
Each polygon defines the area closest to a particular node, useful for 
estimating demand zones or service areas. 

 

 
 

Identifies watershed boundaries and stream paths based on the terrain 
surface (DEM). Useful for integrating surface runoff, catchment analysis, 
and planning stormwater management alongside water distribution 
systems. 
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Importing SRTM30M DEM from server 
 
This tool connects to an online data source (typically NASA or USGS servers) to automatically download 
SRTM (Shuttle Radar Topography Mission) Digital Elevation Model data with a 30-meter spatial 
resolution for a selected area. The DEM provides essential topographic information used to 
understand the terrain of a region, which directly affects water flow, pressure zones, drainage patterns, 
and catchment behaviour. Integrating this elevation data into a GIS-based model enhances the 
accuracy of hydraulic simulations and is particularly valuable for regions without local topographic 
surveys. 
 
Clicking on the Importing SRTM30M DEM From Server button will import the data and create a new 
layer (called SRTM 30M, the name of which can be changed). Selecting the created layer and setting 
its Layer Properties to show a colour ramp of the elevations Figure 12-2 (and in this case also set the 
transparency level to see the Google Earth image behind it. 
 

 
Figure 12-2: SRTM 30M DEM imported from server 

 
Generate DEM (Digital Elevation Model) 
 
This function allows the user to create a custom Digital Elevation Model from local data sources such 
as surveyed elevation points, GPS data, or contour lines. It uses interpolation algorithms to generate 
a continuous elevation surface that reflects the terrain's shape. The generated DEM can then be used 
for hydrologic and hydraulic modelling, including flow direction analysis, slope calculations, and 
defining natural drainage patterns. This tool is essential when more detailed or localized elevation 
data is available and preferred over global datasets like SRTM. 
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Select a DEM Clicking on the Generate DEM (Digital Elevation Model) button the user will receive a 
prompt to enter the Cell size as shown in Figure 12-3. A DEM is a grid of cells, each representing the 
average elevation over a square area. The cell size determines how much ground area each cell covers. 
CƻǊ ŜȄŀƳǇƭŜΣ ŀ ŎŜƭƭ ǎƛȊŜ ƻŦ мл ƳŜǘŜǊǎ ƳŜŀƴǎ ŜŀŎƘ ǇƛȄŜƭ ƛƴ ǘƘŜ 59a ŎƻǾŜǊǎ ŀ мл Ҏ мл ƳŜǘŜǊ ŀǊŜŀ ƻƴ ǘƘŜ 
ground. 
 

¶ Smaller cell sizes provide more detailed elevation data, capturing finer terrain features. 

¶ Larger cell sizes result in coarser DEMs with smoother, more generalized terrain. 
 
Set the Cell Size and click on the OK button. 
 

 
Figure 12-3: Generate DEM - Set Cell Size 

 
The DEM will be created, Figure 12-4, and listed as a new Layer in the project. 
 

 
Figure 12-4: Generated terrain 

 
Export Image 
 
The Export Image tool allows users to capture the current view of the GIS project and save it as a raster 
image file, such as PNG or JPEG. This is especially useful for preparing visuals for reports, presentations, 
or documentation where a snapshot of the model layout, pipe network, or terrain features is required. 
Users can typically select the resolution and extent of the exported image, making it a valuable tool 
for communicating the spatial layout and design features of a water distribution or drainage system. 
 
Clicking on the Export Image button will show the dialog window as shown in Figure 12-5. Set the 
following parameters as listed in Table 12-2, and click on the OK button. The user can then select the 
directory and file name where the image should be stored. 
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Figure 12-5: Export Image dialog window 

 
Table 12-2: Export image parameters 

Parameter Description 

X Min The minimum X (longitude or easting) coordinate of the bounding box (lower-left 
corner) of the selected spatial extent. 

X Max The maximum X (longitude or easting) coordinate of the bounding box (upper-right 
corner) of the selected spatial extent. 

Y Min The minimum Y (latitude or northing) coordinate of the bounding box (lower-left 
corner) of the selected spatial extent. 

Y Max The maximum Y (latitude or northing) coordinate of the bounding box (upper-right 
corner) of the selected spatial extent. 

Source 
EPSG 

The EPSG code of the coordinate reference system used for the input spatial data. 
EPSG:3857 is Web Mercator projection commonly used in web maps. This would be 
the current source of the layer selected 

Target 
EPSG 

The EPSG code of the coordinate reference system to which the data will be 
transformed or reprojected. 

Cols The number of columns (grid cells horizontally) in the raster grid to be generated. 
Maximum number is 15. 

Rows The number of rows (grid cells vertically) in the raster grid to be generated. Maximum 
number is 15. 

Image Type The output format of the image or raster, e.g., TIF (Tagged Image File Format), which 
supports georeferencing or JPG, PNG & BMP. 

Image Size The resolution or size of the output image in pixels. In this case, it defines a square 
image of 1024 × 1024 pixels. 

 
 
Raster to Vector 
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Raster to Vector conversion transforms pixel-based data (e.g., scanned maps, aerial photos, or DEMs) 
into vector features (points, lines, and polygons) that can be edited and analysed in GIS. For example, 
contours from a scanned topographic map can be traced and converted into elevation lines, or roads 
and infrastructure visible on a satellite image can be digitized into vector paths. This tool automates 
part of the digitizing process, allowing for more efficient creation of geospatial features that are 
necessary for modelling and analysis in GISpipe. 
 
When the user selects a raster layer and click on the Raster to Vector button the Tolerance can be set 
as shown in Figure 12-6. The tolerance refers to a numerical threshold that determines how precisely 
the vector shapes follow the boundaries or features in the raster image. For example, if a scanned 
map of a pipeline is vectorized: 
 

¶ A low tolerance (e.g., 0.5) will trace every minor bend or pixel-level fluctuation. 

¶ A high tolerance (e.g., 5.0) will produce straighter, smoother lines, potentially ignoring minor 
deviations. 

 

 
Figure 12-6: Setting Tolerance for raster conversion 

 
Once the process has been completed a new Vector layer is created as shown in Figure 12-7. 
 

 
Figure 12-7: Vector layer created 

 
 
 
 
Convert Excel File to Shapefile 
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This tool enables the conversion of tabular data from Excel spreadsheets into spatial vector data in 
the form of shapefiles. If an Excel file contains columns for coordinates (e.g., latitude and longitude or 
X and Y), along with attribute data like elevation, node IDs, or demand values, this tool creates 
corresponding point features in the GIS environment. It is particularly useful for importing survey data, 
pump station locations, or customer demand nodes into the GISpipe system, allowing for easy 
integration of non-spatial data into a spatially-aware model. 
 
Clicking on the Convert Excel File to Shapefile button will show the dialog window as shown in Figure 
12-8. Click on the Open Excel File button and after the file was loaded select which column is the X- 
and which is the Y-coordinate. Click on the OK button to create the Shapfile. The user can then select 
the directory and file name where the shapefile should be stored. It is not automatically added as a 
layer. The user has the option to add it to the project using the procedure as described in Section 9.2.1. 
 

 
Figure 12-8: Convert Excel File to Shapefile 

 
Set Elevation 
 
The Set Elevation function assigns elevation values to specific nodes, such as junctions, tanks, and 
reservoirs, within the water distribution network. Elevations can be set manually or derived 
automatically from an underlying DEM or contour data. Accurate elevation information is critical for 
hydraulic modelling because it affects pressure calculations, head loss, and flow dynamics throughout 
the network. This tool ensures that every element in the model reflects realistic terrain influences, 
improving the fidelity of simulations and design evaluations. 
 
The user can select the layer with the nodes that needs to be obtained from the DEM. Click on the 
Set Elevation button after which the user will be prompted to enter the Pipe Depth as well as select 
if this function should only be applied to selected nodes (toggle option) or if it will be applied to all 
the nodes in the layer as shown in Figure 12-9.  
 
Set the Pipe depth and click on the OK button. The nodes on the selected layer will all be changed 
based on the DEM information. 
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Figure 12-9: Set elevation 

 
Get Building from Web 
 
This feature connects to online geospatial databasesτsuch as OpenStreetMap or other public GIS 
servicesτto import building footprints and structural data into the project area. This allows users to 
visualize residential, commercial, or industrial buildings, aiding in estimating water demand, planning 
service coverage, or evaluating the impact of infrastructure placement. The buildings are downloaded 
as vector polygons and can be used for further spatial analysis, such as proximity to pipelines, 
population density mapping, or identifying high-demand zones. 
 
Click on the Get Building from Web button to start the process to download this information (this 
process can take a few minutes depending on the size of the area). A 3D view of the terrain will show 
the variations in elevations and structures which are shown based on their heights, see Figure 12-10.  
 

 
Figure 12-10: 3D view 

 
Generate Voronoi Layer from Junctions 
 
This tool generates a Voronoi (or Thiessen) diagram from selected network junctions or nodes, 
creating polygons around each node such that any point within a polygon is closer to its central node 
than to any other. These polygons represent service areas or demand zones and are helpful in water 
distribution modelling to allocate population, demand, or land use data to the nearest supply point. 
This spatial partitioning supports network optimization, balancing demand, and locating new 
infrastructure more effectively. 
 



 

GISpipe ς User manual 129 

Select the layer with nodes. Click on the Generate Voronoi Layer from Junctions button to generate 
the Voronoi (or Thiessen) diagram from the junctions as shown in Figure 12-11. 
 

 
Figure 12-11: Generated Voronoi Layer from Junctions 

 
Once the process has been completed a new Voronoi layer is created and its properties can be set as 
previously described in Section 9.2.1. 
 
Generate Basin & Stream 
 
The Generate Basin & Stream tool performs hydrologic analysis using elevation data (DEM) to 
delineate watershed boundaries and identify natural stream paths. It calculates flow direction and 
accumulation based on terrain slope, then defines catchment areas and the likely routes of surface 
water runoff. This tool is useful for integrating surface hydrology with piped infrastructure, assessing 
flood risk, designing stormwater systems, or planning sustainable drainage. The output helps visualize 
how natural terrain influences water movement, supporting comprehensive water resource 
management. 
 
Select the layer that contains the DEM data. Click on the Generate Basin & Stream button after which 
the user will be prompted  about the Precision Generation and the Accuracy can be selected from the 
drop-down list (1 to 9) as shown in Figure 12-12. 
 

 
Figure 12-12: Precision Generation for Basins and Streams 

 










